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Chapter 1. Overview

About This Book

This manual is divided into the following chapters.

Chapter 1. Overview (page 5)
Includes a general product description, functional description, technical specifications, and
ordering information.

Chapter 2. Installation Instructions (page 15)
Provides overview information about the installation process and equipment, as well as instructions
for receipt and inspection of the OA850C NR.

Chapter 3. Mounting the OA850C NR (page 18)
Provides the information you need to mount the OA850C NR.

Chapter 4. Powering the OA850C NR (page 27)
Provides information about AC power, DC power, modem, and alarm and control wiring.

Chapter 5. Orienting and Isolating Antennas (page 35)
Provides information about antenna mounting, orientation, and isolation.

Chapter 6. Completing Installation (pége 38)
Provides information about activating system power, assigning frequency, configuring initial gain,
veritying and optimizing coverage area, and configuring for alarm reporting and system operation.

Chapter 7. Maintenance and Troubleshooting (page 42)
Includes information about the following topics: routine checks required to maintain performance
and to address problems, return and repair of the OAB50C NR, and the product warranty.

General Repeater Information

The Repeater Technologies Over-the-Air 850C Network Repeater ™ (hereafter referred to as the
OAB850C NR or the repeater) is a bi-directional, on-frequency, over-the-air RF channelized Repeater
for CDMA.

The OA850C NR extends the coverage of PCS base stations. it is available with an optional diversity
receive feature, which improves base station receive performance in high-mobility applications.

The repeater receives signals from a Base Transceiver Station (BTS) and re-transmits them to a
subscriber Personal Communications Service (PCS) telephone; likewise, the repeater receives signals
from a subscriber telephone and re-transmits them to the BTS. Repeaters significantly improve
coverage in areas with weak signal reception or transmission.

The OA850C NR is designed for indoor or outdoor installation and can be either wall or pole mounted.
The unit's compact cabinet simplifies installation, while its aesthetically acceptable design allows it to
be zoned easily in many locations. The repeater only requires initialization. Also, as a field-
replaceable unit, it requires no component-level repair.

OA850C NR Operations Manual Chapter 1. Overview —&
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14.00—

FRONT VIEW )

Figure specific to OA850C
to replace this figure.

L

Figure 1. OAB50C NR Exterior Front View

The repeater consists of the following assemblies:

LNA (Low Noise Amplifier)
PA (Power Amplifier)
Channel Select Filters
Diplexers

Power Supplies

ACU (Alarm and Controt Unit)

All assemblies are mounted on a heatsink and enclosed in a sealed, painted aluminum, weathertight
cabinet. During normal operation, the cabinet housing remains closed. Access to power and to data
transmission connections is provided through an Entry Box, which extends from the bottom of the
cabinet.

Install repeaters and associated hardware in locations suitable for adequate reception of signals from
the BTS and for effective retransmission of these signals to a subscriber.

The OAB50C NR may be equipped with an optional celiular telephone, which is mounted on the interior
of the entry box front door, as shown in the following Entry Box figure. The cellular telephone feature
can be used with RepeaterNet NMS for monitoring a network of repeaters. For more information, see
RepeaterNet Craft for the OA850C NR.

JooooDo

OAS50C NR Operations Manual Chapter 1. Overview — 6
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Figure 2, OA850C NR Entry Box (AC)

Functional Description

The OA850C NR uses a unique Intermediate Frequency (IF)} filtering design to achieve a high degree
of selectivity. It also uses a common local oscillator for up-and down-conversion to prevent frequency

conversion error.
The RepeaterNet Craft software is the configuration management and alarm monitoring interface for

the OA850C NR. The repeater has two communication (COM) ports for RepeaterNet connections—a
serial port for direct, laptop connections and a modem port for remote connections.

An Automatic Level Control (ALC) circuit protects the repeater’s circuitry from potentially damaging
high input levels and minimizes the generation of Intermodulation Distortion (IMD) in the transmit
power amplifier. The following figure is a block diagram of the QAS850C NR.

The signal processing flow through the repeater in the forward direction {BTS to mobile) is similar to
the flow in the reverse direction (mobile to BTS).

OAS850C NR Operations Manual Chapter 1. Overview—7
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Figure 3. Simpiified 1-Ctiannél OAB850C NR Block Diagram—Signal Flow

Signal flow is as follows:

1.

The received signal from the BTS antenna enters the repeater through the cabinet-mounted Type
N (f) connector, and feeds to a branching circulator and a diplexer filter.

The signal then is amplified by an LNA and down-converted to an Intermediate Frequency (IF).

After being filtered by Surface Acoustic Wave (SAW) filters, the output signal is up-converted and
precisely restored to the original RF frequency by using the same Local Oscillator (LO) as the one
in the down-converter.

The signal then passes through a bandpass filter to eliminate unwanted sidebands and LO
leakage.

The transmit power-amplifier further amplifies the signal to achieve final transmit Radio Frequency
(RF) power levels. See Table 2 for specific information about power output.

The signal finally routes through the output diplexer to the mobile antenna. (The diplexers permit
use of common antennas for both transmit and receive signals while effectively separating the
receive band from the transmit band.)

Licensing

All owners of the OA850C NR should consult with the appropriate local and national agencies for
information on licensing.

OAB850C NR Operations Manual ' Chapter 1. Overview ~ 8
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Technical Specifications

Table 1. Models and Frequency Range

MODELS AND FREQUENCY RANGE (MHz)

MODEL BANDWIDTH BAND FORWARD REVERSE
OABS0C-A 1.5 MHz A 869.0-850.0&8%0.0- 8915 82408350 & B45.0 - B46S
QASS0C-B 1.25MH 880.0-£90.0% 8%1.5-8%4.0 835.0-545.0 & 846.5-B49.0

Table 2. Elecirical Characteristics

ELECTRICAL CHARACTERISTICS

- RF OUTPUT POWER PER CARRIER AT THE ANTENNA PORT GAIN
J.CHANNEL 2.CHANNEL (2 dB steps)
Forvard 25. r4 & 3Wm 6595
Main Reverse +18 dBun - +18 dBm 65-95
Diversity Reverse +18dBm +188m £5-95

Table 3. Mechanical/Electrical Characteristics

MECHANICAL/ELECTRICAL CHARACTERISTICS

INPUT VOLTAGE ANTENNA
POWER CONSUMPTION SIZE WEIGHT OFTIONS TEMPERATURE | . OheEGcTORS
I-channel KO Ware I&H x 14Wx 11.5D (inch) <S01bs. o HO2IOVAC 4P S C TypeN (9
2 charnd 500 Wate (eoral) A06H x ISEVY x 292D (mm) BKg. or +MVDC ambierx

Table 4. Inputs and Outputs

INPUTS AND OUTPUTS

LOCALIO OTUY":}E" tocAaLro |outrurTyPE | LOCALIO OUTPUT TYPE
- Remote Conrol Extermal Bateery
Critical Alarm | Form CRelay Relays (2) Form CRelay Moritor Aralog {DC Volts)
Major Alarm Form CRelay | Digital Ouepues (2) | Opto-lsolated TTL § BUFS Moritor 6 Alarms
Minor Alarm Form C Relay Digital Inpues {2 Opto-Isolated TTL
Table 5. Additional Characteristics
ADDITIONAL CHARCTERISTICS
WAVEFORM QUALITY SPURIOUS IBSAW | conpp | MAXIMUM INPUTSIGNAL
DEGRADATION RESPONSE FILTER DELAY {without darage) VSWR | NOISEFIGURE
FACTOR (rho) BANDWIDTH 9
>09 per [5-9515-97 <1 7ME <6 pisec +10dBm <15l %

OA850C NR Operations Manual
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Table 6. RepeaterNet Alarm, Monitoring, and Control

REPEATERNET ALARM, MONITORING, AND CONTROL

GuUl FUNCTIONS

-R&22(local) | |+ WindowsNT(NMS} | *Inerupe Reportirg

* POTS (dlial-up} * 32-bie » Defirable Threshold
= ¥ireless Modem * Poing-and-click « Remote Control: Gain,
« Wireless Modem Crarwel, and PA OnOFf

Windows®95 (Craf} | * Summary Alarm

Table 7. Alternate Power Options

ALTERNATE POWER OPTIONS

DESCRIPTION

BUPS

2.8 hours of backup power without AC

Sotar Power PV {Photovohtalc) with regulated charging to batteries

Hybrid Sofar and TEG | PV with thermal electric propane generation assistand

Hybrid Solar and MG | PV with propane or diesel generagon assistance

Ordering Information

Consider the following requirements when ordering the OA850C NR.

Table 8. Ordering Considerations

Item

Requirement

Electrical Power

AC or DG, power cord, watertight conduit or connector.

Back-up Power

A power supply in case of interrupted electrical service; note that a Back-
up Power System (BUPS) is available from Repeater Technologies.

Antennas, Donor or

What types are required; what is the intended system coverage. Note

Subscriber that antennas are available from Repeater Technologies.

Coaxial Cabling What type and length are required. Note that coaxial cable is available
from Repeater Technologies.

Mounting Special requirements for the repeater and antennas.

Antenna Interface Connectors

Type N to i DIN Jumper Cables

OA850C NR Operations Manual
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OA850C NR Configurations and Part Numbers

Table 9. Configuration and Part Numbers

Band No. of Voltage Diversity Part Number /
Channels
1 115/230 VAC yes 090-3100-01_/
i 115/230 VAC no 090-3100-03/

1 +24 VDC yes 090-3100-85
A 1 +24 VDC no 090-3106-07
2 115/230 VAC no 090-100-04
2 +24 VDG yes 096-3100-06
i 115/230 VAC yes _#90-3110-01
1 115/230 VAC no / 090-3110-03
1 +24 VDC yes /  090-3110-05
B 1 " +24 VDC no 090-3110-07
2 115/230 VAC no 090-3110-04
2 +24 VDC yes / 090-3110-06
1 115/230 VAC yes/ 090-3120-01
1 115/230 VAC né 090-3120-03
1 +24 VDC /yes 090-3120-05
c 1 +24 VDC / no 090-3120-07
2 115/230VAC |/ no 090-3120-04
2 +24VDC /] yes 090-3120-06
1 115/230 VAG/ yes 090-3130-01
1 115/230 VHC no 090-3130-03
1 +24 VPC yes 090-3130-05
D 1 +24YDC no 090-3130-07
2 115230 VAC no 090-3130-04
2 / +24VDC yes 090-3130-06
1 / 115/230 VAC yes 090-3140-01
1 A 115/230 VAC no 090-3140-03
1/ +24 VDC yes 090-3140-05
E 1/ +24 VDC no 090-3140-07
2 115/230 VAC no 090-3140-04
/2 +24 VDC yes 090-3140-06
/1 115/230 VAC yes 090-3150-01
1 115/230 VAC no 090-3150-03
1 +24 VDC yes 090-3150-05
F 1 +24 VDC no 090-3150-07
2 115/230 VAC no 080-3150-04
2 +24 VDC yes 090-3150-06

OAB50C NR Operations Manual Chapter 1. Overview — 11
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Optional Equipment Available from Repeater Technologies
Table 10. Spare Paris and Accessory ltems

Description Part Number

Antennas* Call for information.

Connectors ' Call for information.

Coaxial Cable Call for information.

Power Cord 103-0137-01

Solar Shields To be announced.

Pole Mounting Kit 137-0438-01

McMaster-Carr %-inch Banding Kit FPart No. 5653K12, McMaster-Carr Supply Co.,
Los Angeles, CA, USA,, Tel. # (562} 692-591 1)

Cabinet Door 024-0978-02 v

I/O Entry Box with Cover ~ 024-1004-01

/O Box Cover Gasket 022-0120-02

/0 Box Gasket 022-0121-01

internal Lead Acid Back-up Battery - _ 149-0852-01

PC Interface Cable DB 9-Pin Female-to-Female 187-0713-01

Modem Module 087-1524-01

Wireless Interface Cable 187-0877-01

Wireless Antenna I/O - N(F) to SMA(F) Bulk head adapter | 142-0521-01

connection

800 MHz Mag Mount Antenna for Wireless IO, & cabla 149-0934-01
with N(M) connector

Cellular Phone (Oki-1430) 149-0924-01
BUPS-25/40 250-1103-02
BUPS-25/80 250-1011-07
Surge Protector - N{M) to N(F) Lightening 149-0932-01
Operations Manual (Hard Copy) 550-3100-01
Operations Manual (CD-ROM) To be announced.
Alarm, Power, and Growth Cabinet Button Piugs 137-0446-01
Conduit Fitting 137-0447-01
Back Mounting Plate 020-1229-03
Stainless Steel %" Locking Washer 125-0059-07
Stainless Stee! %" x 1" Flat Washer 125-0068-07
Stainless Steel Pin-in Head Security Bolts 125-0212-13
Stainless Steel Hex Head Bit Pin-in Head, "/ 129-0007-08
Door Hinge Set 137-0428-01
Allen Wrench 129-0007-02
RepeaterNet NMS Craft Software 519-1200-03
BUPS Power & Alarm Cable Assy {Kit) 187-0188-01

*Typical antennas inciude parabolic reflectors, comner reflectors, circular, linear, directional co-linears,
cross or slant polarization, log periodic array, or Yagi.

OA850C NR Operations Manual Chapter 1. Overview — 12
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Back-up Power System

To select a BUPS (Back-up Power System) for your application, match the repeater you are using with
the amount of back-up time required.

Table 11. Back-up Power System Selection Guide

Power Calculated Back-up Hours
Product Consumption Current BUPS-25/40 | BUPS-25/80

Mode! Number @ 24 Vdc @ 24 Vde 25A40A-H | 25 A 80 A-H
OAB50C, %-a-4ett, 1-channel 7 W 310W 1292 A 341 6.2
OAB50C Growth Cabinet, 6-8-Jall, 570 W 23.75A 1.7 34
2-channel* 7w
*Growth cabinet power (2" channel power) is the sum of the Repeater plus the growth cabinet: 310 W+
260 W =570 W.

Accessory Kit ltems

Table 12. Contents of AC and DC Accessory Kits

AC Accessory Kit (P/N 091-0105-01) DC Accessory Kit (P/N 091-0105-02)
ltems Quantity Items Quantity
Power Cord 1 each BUPS Powr and Alarm Cable 1 each
Assembly

Wrench, Hex Key (Allen Wrench) 1 each Wrench, Hex Key {Allen Wrench} 1 each
PC Interface Cable 9B-D-SUB/8P- 1 each PC Interface Cable 98-D-SUB/8P- 1 each
suB SuB _

Hex Bit, Pin-in-Socket, 732 1each | Hex Bit, Pin-in-Socket, 732 1 each
Alarm, Power, and Growth Cabinet 4 each Alarm, Power, and Growth Cabinet 4 each
Button Plugs Button Plugs

Conduit Fitting 4 each Conduit Fitting 4 each
Operations Manual (Hard Copy) 1 each Qperations Manual (Hard Copy) 1 each
RepeaterNet Craft Software 1 disk RepeaterNet Craft Software 1 disk

Ordering Procedure

When ordering, specify a shipping destination and a billing address. Repeater Technologies will return
an order acknowledgment with the scheduled shipping date. Each shipment includes an equipment list
showing the equipment ordered and shipped, including details about system and equipment options.
Contact the Repeater Technologies Sales Department for ordering information.

Technical Services

Repeater Technologies offers technical services to supplement the manpower resources of its
customers. Quotations for the following services are available upon request.

Site and construction surveys

Network design

Design verification

Training

Installation

Accessories (antennas, coaxial cabling, and so on)

Oo0OoOoD
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Contacting Repeater Technologies

Contact the Repeater Technologies corporate headquarters for sales information or technical
assistance for the OA850C NR, or for any other of our communications or related products.

Corporate Headquarters

1150 Morse Avenue
Sunnyvale, CA 94089-1605 USA

Tel: (408) 747-1900
(888) 747-1515 (USA and Canada)
Fax: (408) 747-0375
Web: - www.repeaters.com
Customer Service B
Tel: (408) 747-1946 -

(800) 928-1901 (USA and Canada}
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Chapter 2. Installation Instructions

Installation Overview

The OA850C NR is designed for indoor or outdoor installation and can be either wall-mounted or
pole-mounted. The unit's compact cabinet simplifies installation, while its aesthetically acceptable
design allows it to be easily zoned in many locations.

Because the RepeaterNet Craft software is used during the physical installation of the repeater, pre-
load the Craft software on the laptop computer to be used at the installation site. See RepeaterNet
Craft for the QA850C NR for information about installing and using RepeaterNet. Bring a DB-9 cable to
the installation site to connect your laptop with the repeater.

NOTE: Only qualified service or technical personnel should install the OA850C NR.

'

See the following illustration of a typical repeater installation with installed components,

Subscriber f Mobile /

Re-Rad Antenna . Donor / Cell Site
- Antenna
y Diversity
Antenna

Jumper H] Y : Jumper

[ Jumper Repeater

Coax Coax

Jumper Jumper

System Ground

Telephone Line
{if applicable)

a

DC Power AC Power
or BUPS {optional}

Figure 4. Typical Installation
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Receipt and Inspection of the OA850C NR

inspect the OA850C NR for damage immediately upon receipt; note any damage on the waybill. Be
sure to request that the delivery agent sign the waybill ior verification. Shouid damage be found:

g Notify the transfer company as soon as possible
a Submit a damage report to the carrier
a Inform the Field Services Department of Repeater Technologies in writing

NOTE: Save original shipping carton and packing materials for any future transport of the unit.

After unpacking the equipment, inventory the contents against the packing lists. Inspect the unit
thoroughty for damage hidden by the packaging, paying particular attention to the following:

o Bent or dented sheet metal

o Loose or broken components

g Damaged connectors .
a Damaged or broken wiring or coaxial cables

Also, inspect the contents of the accessory kit and any optional equipment ordered with the unit.

Installation Equipment

See the following table for a list of required installation equipment. Additional equipment could be
needed, depending upon specific installation site requirements and optional accessories ordered.

NOTE: The Path Data Sheet and site plan are needed during instalfation to define the intended

parameters of the project, including coverage area, gain settings, and antenna location. If
necessary, consult a network administrator for more information.

Table 13. Required Instaliation Equipment

Use this equipment:

To:

Site Plan/Network Engineering documentation

Correctly configure the repeater to operate in the PCS
network

Ratchet or Hex Screwdriver for /o Pin-in-
Socket Driver

Detach security screws

Voitmeter, Fluke 75*

Test power connections and analog test points

Spectrum Analyzer HP 8591

Test power output

Cellutar Service Monitor with Signal
Generator, IFR-1500, HP-8594A°

Test antenna isolation and repsater power

Type N {m) 50-ohm Termination, 20 W, (2 ea.)

Terminate antenna poris during off-air test

Mounting Hardware

Mount repeater and antennas

Electrical Wiring Equipment (as needed)

Connect external systems to input and output connectors

Laptop Computer (with RepeaterNet installed)

Control and monitor the repeater

Accessory Kit

Mount and install the repeater

Pole Mounting Kit and Tightening/Crimping
Tool (for pole mounting only)

Mount the repeater to a pole and secure pole mounting
straps

*Equivalent substitute can be used.

OA850C NR Operations Manual
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Site Survey

Review the installation site thoroughly before mounting antennas or the OA850C NR. Site review
should include, but not necessarily be limited to:

Weather :
Determine whether environmental conditions necessitate special shielding of the Repeater or other
equipment.

Security
Determine whether some type of barrier is needed to protect equipment and whether a security
light is required.

Optional Site Equipment
Determine whether additional site equipment, such as a pump, generator, or light is required. i so,
where is the equipment to be located, and are special enclosures for any equipment required.

Wiring and Wiring Access
Determine any special wiring requirements.

Cabinet Access
Determine whether there is enoygh room for the repeater door to open once mounted.

CAUTION: In an extremely hot environment, such as a desert, shading from direct sunlight may be
necessary to prevent the repeater and associated equipment from overheating.
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Chapter 3. Mounting the Repeater ~

Mounting Associated Equipment

Mount the OA850C NR assembly antennas, antenna coaxial cabling, and BUPS (if used) before
mounting and wiring the repeater. '

If you intend to add a second frequency channel, you will need to install a growth cabinet to house the
second channel. Be sure to allow enough space either above or to the right of the repeater for
mounting; examples are shown in the following figure.

20"
g — 10"
"l® o S ® " o o ®
- .
- : Growth
) - & ] i
16"
i ¥
Repeater
Figure 5. Mounted Growth Cabinet Examples
——
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Suggested
Suggested
Minimum Minimum ITl |—,—|
Distance Distance
10" 6" L—-—-—I
BUPS-25/80
°© o @ ( Backup Power
Mailn System )

(Primary)
Cabinet

3
s
3
3

L=+ = TS

Figure 6. Growth Cabinet Example with BUPS-25/80

Mounting and Connecting Antennas

Antenna size is specified on the Path Data Sheet—do not install antennas of a different size. The size
of antenna coaxial cabling for an application depends upon a number of system parameters including,
but not limited to:

O Redquired signal output
a Antenna gain
o Transmission line length

The allowable path loss for antenna cabling, and therefore the size of the cabling, is specified on the
Path Data Sheet for the project. Do not install cabling of a different size than specified on the Path
Data Sheet.

NOTES:

Q As a signal passes through coaxial cable, the strength of that signal decreases. This loss of signal
strength, known as path loss, decreases as the diameter of the cable increases.

O Check the diameter of the coaxial cable before installing. If the cable is more than ¥%-inch (1.3 cm)
in diameter, attach a coaxial jumper assembly (which you must supply) to the connector on the
antenna cable. Make the jumper assembly of J-inch (1.3 cm) coaxial cabling and use "As DIN or a
Type N connector, one male and one female.
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To install coaxial cabling to the Base and Mobile antennas:

1. Make sure the coaxial cable is long enough to reach the OA850C NR installation site.
2. Install either a 746 DIN (m) or a Type N (m)} connector on the coaxial cabie.
3. Connect cables to the Base and Mobile antennas.

CAUTION: /f a coaxial cable is larger than ¥%-inch (1.3 cm) in diameter, do not connect it _
directly to an antenna port on the repeater, as possible damage could resuft, Using
a coaxial jumper assembly reduces strain on equipment connectors.

4. Having read the above caution, connect the other end of the antenna cables to the appropriate
ports labeled on the bottom of the repeater.

You can mount the OA850C NR on a pole or on the wall of a building. The OA850C NR is shipped with
the rear mounting bracket attached to the unit.

The following figure illustrates the bracket with dimensions.

4.50 5.00 .

: f
0325 ™ - — 1] 1-25 2x

15.232X
11.5:)
R e
| _1.'23 A
10.00
13.78

Figure 7. Rear Mounting Bracket
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The following figure shows a side view of the OAB50C NR and the rear mounting bracket.

[’ o= Guide Bolt and Siot

Security Bolts
(Tamper Proof)

x4

Rear Mounting Bracket

Figure 8. Rear Mounting Bracket with Unit—Side View

Wall Mounting
Wall mounting hardware, which can be ordered from Repeater Technologies, contains the following:

a Four (4) lag bolts
O Four (4) filat washers
O Four (4) lock (split} washers

To mount the OA850C NR on a wall:

1. Separate the rear mounting bracket from the Repeater by removing the attachment bolts and
washers (using a ratchet or hex screwdriver and the 132 pin-in-socket driver provided in the
accessory Kit).

2. Using the mounting hardware, secure the bracket to a wall—see the following figure.
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e

4X Flat Washer

4X Lock Washer

4X Bolt

Figure 9. Installation of Rear Mounting Bracket on a Wall

Set the repeater into the bracket by sliding the guide bolt into the guide slot, then replace the
attachment bolts and washers removed in Step 1—see the following two figures.

Guide Bolt and Slot

Figure 10. Guide Bolt and Slot
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e

L \/ 4X Bolt

4X Lock Washer

4X Flat Washer

Figure 11. Repeater Mounting and Hardware Placement

Pole Mounting

Repeater Technologies. offers optional pole mounting equipment for the OA850C NR, available when
ordering the OA850C NR.

Pole installation requires the following materials:
o Pole mounting kit (available from Repeater Technologies)

O Banding kit (purchased separately; available from McMaster-Carr) if you are mounting the repeater
on a concrete or metal pole

Q Class A - Pole Line Hardware if you are bolting the Pole Mounting Bracket to a wood pole

The Pole Mounting Channel is designed so that the repeater is “squarely” mounted on the pole and
does not wobble.

If a concrete pole is used as the mounting structure, typically it is not prudent to try and drill a hole
through its center. Similarly, because metal poles may have cable run up the center, drilling is not
recommended. Banding is preferred over drilling. However, wood telephone-type poles are forgiving
and the pole-mounting channel can be easily fastened to the pole with lag screws or through-pole
bolts.
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(Class A Pole - Line Hardware is a telephone term that specifies bolts and screws that have a heavy
electro-galvanized plating so they do not rust.) This type of ruggedized hardware typically is available
from distributors such as Garybar Electric, ALLTEL Supply, Spring-North Supply, PowerTel Supply,
and so on. This hardware is also available from antenna suppliers and tower erector companies.)

The following table describes the Pole Mounting and Banding Kits. Because the Banding Kit comes
with 100 feet of band, you need not purchase a kit with every repeater.

Pole Mounting Kit (091-0215-01)

1 Pole Mounting Channel
4 Bolts
4 Lock (Split) Washers
4 Flat Washers
4 Tapered Plug, .312D Hole
%-Inch Banding Kit (Part No. 5653K12)
{McMaster-Carr Supply Co., Los Angeles, CA, USA, Tel. # (562) 692-5911 ')
1 Tightening-Crimping Tool )
100 fi. Y-inch, Type201 Stainless Stee! Band
100 Stainless Steel Buckles
25 Stainless Steel Scru-Lockt Buckles
1 Carrying Case

NOTE: Two people are required for pole mounting.

To mount the OA850C NR to a pole:

1. Remove the attachment bolts and washers, then separate the rear mounting bracket from the
repeater.

2. Using the hardware provided with the accessory kit, secure the rear mounting bracket to the two
(2) pole brackets—see Figure 12 on page 25.

Insert the 4 plugs provided into the 4 outer holes in the rear mounting bracket.

Position the rear mounting bracket (with the attached pole channel) against the pole and hold it in
place.

5. While one person holds the rear mounting bracket in place, the second person installs the steel
bands that hold the bracket against the pole. Consult the manufacturer’s instructions included with
the Banding Kit for this procedure.

6. Set the repeater into the bracket by sliding the guide bolt into the guide 'slot.
Secure the repeater to the bracket with the security screws and washers removed in Step 1.
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Two 7/9" dia. holes for 3/4” @N,;
lag of thru-pole boits 1% i
~ 1
v -
—/‘ /'
§ | s "
e
/') B
3)5/:%/'//‘ ' ! ~ T A
| v Pole
. A il “_Mounting
e | . Y \ﬂ Channet
Lt i L~
~ A .
& k
o - ' 4 x Plug
g e
4 x Flat Washer '
- 4 x Lock Washer
4 x Bolt
Fi_&ure 12, Pole Mounting Hardware
Lifting
Asslst
Hole 34" Thru-pole
Bolts with Flat
Washers and
/ ‘ Locking Aero Nut
Pole AT
Mounting / \! “
Channel
Repeater Banding
Mounting Straps
Bracket

g ;‘ — Pole or Mast

Figure 13. Pole Mount—Side View
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Grounding the Repeater

If detailed grounding information is r.
Installation Standards for Groun
of this application note.

equired, refer to the Repeater Technologies application note,
ding Requirements. Contact Repeater Technologies to receive a copy

Connect the screw-compression ground lug (located on the left exterior of the Entry Box} to a suitable

earth ground {copper ground rod, copper pipe, grounded steel building frame, or similar ground point)
using 2to 7 mm, No. 6 to 2 AWG, copper wire—see the following figure.

CAUTION: Ground all other cabinets, enclosures, antennas, and coaxial cables used for instalfation to
reduce any damage from a lightning strike or power surge.

System Ground /

"L '}, S5feet(2m)
: ' minimum

Standard Ground Rod
Ya-inch diameter

Figure 14. Typical System Ground
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Chapter 4. Powering the OA850C NR

The OA850C NR is factory-configured with one of the following AC or DC re) power supplies:

Q 115 VAC/230 VAC £10% (available)
0 24 VDCM8MBE+10% Heaiste:

NOTE: When wiring power to the repeater, match the voltage of the repeater to the voltage of the
power supply.

AC Power Wiring

See thé following figure for the location of power features. Note that the AC power cord enters the
Entry Box through the left-most conduit and that the free end of the cord is equipped with a 3-prong
plug. Also, the AC plug used for wiring is shipped connected to the J18 receptacle. ..

Power o ﬁ o 0 o

Switch oo - oND oD oo 0o E
Pl . O e
uen wour Owmw
" a Oun ||
”_ooooooocooooooojo,m
AC e 11v220 VAC ey LI T =
Receptaclp 000000CAD000BOT ]

HE GND £ |
oo oo [] 'Il. [] I—
- E o E HaT USER RELAY ALARM RELAY
Q , i < \ Qo
/ \
_/ \ Green LED, Power ON

Grounding Stud

Figure 15. Power Features

To wire the AC power leads to the repeater:

1. Using a medium Phillips head screwdriver, remove the Entry Box access plate located at the
front/bottom of the unit.

2. Feed the open end of the power cord through the left-most conduit and into the Entry Box. Note
that the color coding of the wires is as follows:

White = Neutral NOTE: Check polarity with a
Black = Live / Hot voltometer before wiring.
Yellow/Green = Ground

3. Remove the nut from the grounding stud.

4. Attach the ring lug terminal of the grounding wire to the grounding stud and replace the nut.
Tighten the nut until the terminal is secure.

5. Locate the AC plug connected to the J18 receptacle, and note the labels next to the plug: COM
(common) designates the location of the neutral wire and HOT designates the location of the live
wire.
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6. Unplug the AC plug from the J18 receptacle and loosen the two end terminal screws. The middle
terminal screw is not used.

7. Insert the Live and Common wires into the proper wire guard receptacles, then tighten the terminal
scraws to clamp wires. (If necessary, reinsert the AC into the J18 receptacle to determine proper
wire locations.)

8. Re-insert the wire AG plug into the J18 receptacle.
To connect power.

1. Turn OFF the external power source {the circuit breaker). The power supply should be a fuse or
circuit breaker rated at 10 amps for 115 VAC or 7.5 amps for 230 VAC mains.

Plug the cord from the conduit into the circuit breaker box (if there is an appropriate outlet).

If there is no outlet, cut off the plug from the power cord and expose the 3 colored leads. Strip
about % inch (o cm) from the end of each wire.

4. If the leads do not reach to the circuit breaker box, measure and cut wiring to make up the
difference. Use #14 AWG wire for live and neutral lines, and #10 AWG for the ground line.

5. Connect the ends of the leads to the appropriate terminals in the circuit breaker box. Match live,
neutral, and ground lines to the correct connections. The color coding of the wires is as
follows: ’

White = Neutral NOTE: Check polarity with a
Black = Live / Hot voltometer before wiring.
Yellow/Green = Ground

6. Wrap any exposed connections with electrical tape to avoid shons.

7. Neatly arrange or secure and, if necessary, environmentally protect power wiring.

CAUTION: Do not activate AC power at this time.

DC Power Wiring
The BUPS-25/80 provides backup DC power to your repeater.

The following is a diagram of the OA850C Network Repeater to BUPS-25/80 Wiring Kit. This diagram,
as well as Figure 6. Growth Cabinet Example with BUPS-25/80 on page 19, aré provided for
planning purposes.

For more information, refer to your BUPS documentation.
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71220 Vac

Neutral

BUPS-25/80 :O:I: :;Iﬂ.": :?:a o OAB50C NETWORK REPEATER
CHARGER y . TERMINAL BLOCKS
Ext. T r Alarm
TERMINAL BLOCK empe
3] J
ANOUT)
@]  1-vighal Output 1
- @|  2-Digital Output 2
o b 3 - DC Voltage Input {(Monitor)
P! 4.Dighalinput 1
@] 5. pigital lnput 2
o & - Forward PA Shutdown
. 7 - Reverse PA Shutdown
42
1 — External Tamper Alarm (Secondary Door Alarm)
2 - UPS Tamper Input (External Input Alarm)
2 - UPS AC Fail Input {(External Input Alarm)
4 - UPS Low Battery Yoitage Input (Externat Input Alarm)
o § - UPS High Battery Voltage Input (External Input Alarm}
& — UPS Charger Fail iInput (External Input Alarm}
[ 7 — UPS Summary Normally Closed {External input Alarm)
8 - UPS Summary Com {Protected Ground)
- t " "ﬁh - 8 Fi. Belden 8743, 22 AWG Solid, 6 Twisted Pairs, PVC Insulatlon, 150V -
N i ) 80 deg., Jacket cut back 47, Conductor ends strippad back %", Grd. Lug
W and terminated in single yeliow #10 spade tenminal. (Part of RTI Part
No. 167-0188-01, Power & Alarm Cable Assembly)}
- MAIN Legend:
L" > + DC 9
M} m , INPUT #22 AWG
. Chassis Ground and - —— #10 AWG
4 .
' { w=— 24 Vdc are common in ®(’ #10 AWG Spade Term.
i __..‘ * repeater ) .
G d aND L L GND #6 AWG Spade Term.
TOUNT i mp. x; - @ Luc -
\ #10-12 AWG Pin Term.
#— Stripped-back & Tinned
& - 172" Liquidtight 8 F1. Royal WO781, 10AWG, Stranded, PVC Insulatien,

OA1900C Network Repeater to BUPS-25/80 Wiring Kit

Tie back leads if

Flex Conduit

300V -60 C, OA1900 ends stripped-back .3" and
tinned, BUPS snds strippad-back and terminated with
#10 Spade Term. (Part of ATI P/N 187-0188-01, BUPS
Power & Alarm Cable Assembly

Figure 16. OA850C NR to BUPS-25/80 Wiring Kit

Alarm and Control Wiring

Repeater installation continues with alarm and control wiring. The following figure shows /O terminal

block designations.

uPs INFOUT
2 N

000000000 000000

I 1] m !

eJelelalelelololelelole e lofe)

] 1[]9 1

USER RELAY

ALARM RELAY

Figure 17. Customer UPS, VO Alarm and Monitoring Terminal Blocks
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The next table shows I/O lead descriptions.

Table 14. Wiring Harness Input/Output Lead Descriptions

Block Pin No. | Signhal Name Function
1 Digital Output 1 User Controllable Open Collector Driver
2 Digital Output 2 User Controllable Open Collector Driver
J1 3 DC Voltage Input 0-75 V Input Voltage
INJOUT 4 Digital Input 1 External Input Alarm
5 Digital Input 2 External Input Alarm
6 Forward PA Shutdown External PA Control
7 Reverse PA Shutdown External PA Control
1 External Tamper Input Secondary Door Open
2 UPS Tamper Input External Input Alarm '
3 UPS-AC Fail Input External Input Alarm
J2 4 UPS Low Battery Voltage Input External input Alarm
UPs 5 UPS High Battery Voltage Input External Input Alarm
6 UPS Cha}:ger Failure Input External Input Alarm
7 UPS Summary Normally Closed | External Input Alarm
8 UPS Summary COM Protected Ground
1 Critical Relay NO Normally Open Qutput
J22 2 Critical Relay COM Common Input
Alarm Relay 3 Critical Relay NC Normally Closed Output
4 Major Relay NO Normally Open Output
5 Major Relay COM Common Input
6 Major Relay NC Normaily Closed Output
7 Minor Relay NO Normally Open Output
8 Minor Relay COM Common Input
9 Minor Relay NC Normally Closed Output
User 1 NO Normally Open Qutput
User 1 COM Common Input
J23 User 1 NC Normmally Closed Output
User Relay User 2 NO Normally Open Qutput
User 2 COM Common Input
User 2 NC Normally Closed Output

WARNING: When connecting wiring, be sure the wiring assembly is not plugged into the repeater.

Digital Control Outputs

The OA850C NR has two digital outputs, each with one open collector transistor lead. When the output
switch is ON, current flows through a circuit that includes the open collector transistor output—see the
following figure. The reference ground is any of the panel-mounted screw lugs (repeater cabinet
ground}.
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#
/_—""\ ?
@ D) o
Repeater /O
Custom Options
45V
+5V
HC Gate é
To Digital < To Digital
Output To Digital Output
#1 ori2 Output #1 or #2
< #or#2 <
< ] =
= C: LED
A: Logic Gate —

B: Opto-Fsolator

Figure 18. Typical Digital Output Applications

Outputs are not isolated from the repeater's power subsystem. Provide a current source on the positive
lead that does not exceed the following specifications:

Forward Current-Continuous 300 mA
Maximum Positive to Negative Lead Voitage ----------- 50 Volts
Maximum Negative to Positive Lead Voltage ------------ 0 Volts
Leakage Current in OFF State 1pA

See the “ACU Status Screen” in RepeaterNet Craft for the OA850C NFR for instructions about activating
digital outputs. See Table 17 for lead descriptions.

Alarm and Control Relay Outputs

The OA850C NR has both alarm and control relay outputs (Form C) with common, normally open, and
normally closed connections. When attached to the normally open and common leads, an alarm relay
closes a circuit when a critical alarm activates and opens the circuit when the condition clears.

Relay Outputs #1 and #2 open and close circuits according to the relay output controls in RepeaterNet.
For example, to activate an external light when the Relay Control switch is ON, the wiring loop includes
the common connector, the normally open connector, a power source for the light, and the light—see

the following figure.
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A: Relay B: Light C: Cell Site
Infrastructure ACU

Figure 19. Typlcal Relay Applications
Do not exceed the following specifications with relay connections:

Maximum Switching Volitage and Current: 30 VDC/2 Amps, 200 VDC/200 mA

See the “ACU Status Screen” in RepeaterNet Craft for the OA850C NR for instructions about activating
digital outputs. Table 14 on page 30 shows I/O lead descriptions.

Digital Inputs

The OA1900 NR has digital inputs for external alarm monitoring and for disabling the Forward and
Reverse PAs. Each input triggers an alarm (or disables the PA) if the leads form a high impedance
circuit (an open contact) and clears an alarm if the leads form a low impedance circuit (a contact

closing).

NOTE: /f a PA is disabled using the digital inputs, the PA Alarm is triggered. To avoid triggering a PA
Alarm in this manner, set the PA Alarm severity to disabled—see “Redefining Alarm Severity” in

RepeaterNet Craft for the OA850C NR.

Connect digital inputs with two leads—the digital input lead and any ground lead. See the next two
figures.
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+5V
To Equipment

1KK

—o<f <

1KK
Varistor ~ Ea
Repeater VO
N Custom Options
To Digital Input #1 or #2 To Digital Input #1 or #2 To Digital Input #1 or #2
A: Relay or Switch Input B: Transistor Input C: HC Gate Input

Figure 20. Typical Digital Input Applications

To Fwd/Rev PA
Eqmpment Disable
Repeater VO "“"‘Pe'

Figure 21. Typical PA Disabie Input

Do not exceed the following specifications when connecting digital inputs:

Input Voltage for LOGIC O..vvemeretsrmsirmsersssnnsssanrssssssmssaneiaes <0.5 Volts
Input Voltage for Logic 1 (active alarm/disable PA).............. >4.0 Volts
Maximum INput VOIRAGE. ...curuerrnrrssenisinsnsss s esnssesanasaeacs 5.0 Volts
MiInimum INPUt VORAGE .....ccuimrienesmcmsirsenssnnessssisssssnisneses 0.0 Volts
Maximum INPUE CUITBAL ..o 2mA

OAS850C NR Operations Manual Chapter 4. Powering the OAB50C NR — 33




Preliminary Draft — ATI Confidential

External DC Input Voltage

The OA850C NR has one analog input to monitor an external DC power source. The monitoring range
is from 0 to 60 volts, with a resolution of 250 mV.

Connect an external DC power source to the repeater with a single lead from the positive line/terminal
of the battery—see the following figure.

(-)
AD
Conv. —<
To
Equipment
(+)
Repeater Cabinet < .
Ground
77
Repeater VO
Custom Options
) Batte DC Mon. Battery
ry
77 77
A: Battery B: Battery
(negative ground) (positive ground)

Figure 22. Typical DC Monitoring Applications

CAUTION: Do not alfow any input to exceed the 60 Volts limit.
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Chapter 5. Orienting and Isolating Antennas

Preliminary Antenna Orientation

With the antennas mounted, coaxial cables installed, and the Repeater power OFF, antenna
orientation can begin.

BTS Antenna
To orient the BTS antenna:
1. Disconnect the coaxial cable from the donor BTS antenna at the antenna port on the repeater.
2 Connect the service monitor to the cable from the BTS receiving antenna.

3. While monitoring the control channel assigned to the donor BTS, position the BTS antenna o
maximize the RSL (Received Signal Level).

4. Analyze the signal to ensure it is correct.

NOTE: Record the level of the control channel and other active carriers from the donor BTS for later
reference. -

If the RSL is less than Maximum RF Output Power Level minus Maximum Gain, full repeater cutput
power may not be reached when installed. See Technical Specifications on page 9 for RF output and
maximum gain levels. To correct the problem, reposition the antenna, change the mounting height of
the antenna, or use an antenna with greater gain to reach the required RSL.

Mobile Antenna

The Mobile service antenna can only be bore-sighted (aimed by eye) at this time. Airn the antenna as
closely as possible to its final position. Accuracy is important because the antenna position affects
antenna isolation.

Antenna Fundamentals

An antenna is a transducer between electromagnetic waves in space and voltages or currents in a
transmission line. When transmitting, the antenna converts electrical signals into radio waves; a
receiving antenna reverses the process and transforms radio waves back into electrical signals.

All antennas are directional, transmitting more power in some directions than others. The direction of
maximum transmission or reception is called the boresight direction. The directional properties of an
antenna are described by its radiation pattern, a pictorial representation of relative radiated power
versus direction. Radiation patterns exhibit a lobe structure in which the largest lobe in three-
dimensional space constitutes the beam through which the antenna radiates or receives most of its
power.

The tendency of the antenna to concentrate its radiated power is called gain. The angular width of the
main beam measured between the half-power points is called the beamwidth of the antenna.
Beamwidth and gain vary inversely with each other; a high-gain antenna has a narrow beamwidth and
vice versa. Gain is proportional to the physical area of an antenna expressed in square wavelengths.

Radiation pattern lobes other than the main beam are called sidelobes. The higher the sidelobe level,
the more likely an antenna is to interfere with or be intertered with by a receiver in the direction of the
largest sidelobe.
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An antenina has an operating frequency—the frequency at which the antenna exhibits optimum

performance—and a bandwidth—the frequency range over which the antenna impedance and B
radiation pattern remain within some required tolerance.
Antenna Isolation
To prevent oscillation or severe passband distortion, the antennas must have a port-to-port
isolation equal to 15 dB plus the OA850C NR active gain. For example, an OA850C NR set for a
maximum available gain of 95 dB requires a minimum antenna isolation of 110 dB (95 dB + 15 dB) for
proper operation. ‘
Be aware that the motion of objects near the antennas can change the isolation significantly. If
possible, perform tests with expected objects present to ensure the isolation does not drop below
minimum required levels.
To measure the isolation:
1. Disconnect both antenna signal cables from the antenna ports on the repeater, *°
2. Inject a signal into one of the antennas and measure the power level of that signal at the other
antenna. The difference in power levels {measured in dB) between the injected signal and the
measured signal is the isolation of the antennas.
NOTE: Because antennas are not yet connected to the repeater, isolation is obtained through the air.
3. Repeat the test at several frequencies across the Forward and Reverse passband, confirming that
minimum antenna isolation is met at aff applicable frequencies.
4. If isolation is not met, try repositioning the antennas or adding intervening shielding, and measure
again.
The following method can be used to estimate antenna isolation {referenced to dBd). During T
installation, aiways rely upon actual measurements, not estimated data.
Isol = Ls + Lf + Lo - Gd + ADd - Gr + ADr + XPD
US Standard
ls=-42.2 + 20!091°(F x D), F in MHz, D in feet, Ls in dBd
Metric
Ls=-31.8 + 20Iog16(F x D), Fin MHz, D in meters, Ls in dBd.
Where
The following are all in dB:
Isol Antenna isolation
Ls Antenna separation loss
Lf Total Feedline Loss
Lo Obstruction loss from structure or shield
Gd Gain of antenna toward donor BTS
ADd Angular discrimination of donor BTS antenna toward re-radiation antenna
Gr Gain of re-radiation antenna toward Mobile
ADr Angular discrimination of re-radiation antenna toward donor BTS antenna
XPD Cross polarization discrimination between antennas (if applicable)
———
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Antenna Orientation and Output Measurement
To orient antennas:
1. Turn OFF system power. The power switch is located in the upper left corner of the Entry Box.
Remove the 50-ohm terminators from the antenna ports.
Connect the Donor and Mobile antenna feeders to the proper antenna ports.
Turn ON system power.

s @

Open a session with the repeater by selecting the repeater on the dialog box displayed after the
Welcome screen.

6. Turh ON Forward PA and Reverse PA power:

A) Select Forward PA from the Configuration menu.
B) Click the Control tab.

C) Click the PA Power switeh to turn it ON.

D) Click Apply or OK.

Repeat for Reverse PA.

7. Check Forward PA and Reverse PA RF output power:

A) Select Forward PA from the Configuration menu.

B) Click the Measurements tab.

C) Compare displayed output power levels to the intended RF output power levels for the
system (defined in the site plan or network engineering documentation) and the maximum
output power of the repeater.

8. Repeat for Reverse PA.

NOTE: Forward transmit power increases as the orientation of the Donor antenna is optimized. Make
any required adjustments to the Donor antenna facing the Cell Site to maximize Forward
power output.

Adjusting for Hot Input Levels

The OA850C NR has an adjustable gain range of 30 dB with upper and lower limits defined by the PA
level of the repeater. In some applications, however, hot input levels require that antenna gain be set
below the lower limit of this range.

To set antenna gain below the lower limit of the operating range:

1. Choose a fixed attenuator pad that is able to set the gain to a level about 5 dB lower than what is
required.

2. |nstall the attenuator pad at the antenna port.
3. Make the final upward gain adjustment with RepeaterNet.

NOTE: Ifan attenuator pad is inserted in this manner, RepeaterNet cannot show the actual antenna
gain. For example, if the Attenuator pad reduces gain by 5 dB, the system gain is actually 5 dB
Jower than the setting shown on the PA Properties screen.
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Chapter 6. Completing Installation —

Turning On System Power

RepeaterNet Craft is used for the first time during the installation procedure in this section.
RepeaterNet Craft is the software program that confirms, controls, and monitors the OA850C NR.
Make sure RepeaterNet has been loaded on the laptop computer being used (at the installation site) to
perform the initial configuration of the repeater. If necessary; see RepeaterNet Craft for the OA850C
NR.

To turn ON system power:
1. Terminate the OA850C NR antenna ports with 716 DIN or Type N 50 OHM Power Loads.

2. Using a medium Phillips head screwdriver, remove the Entry Box access plate located at the front
bottom of the unit and locate the internal backup battery. (See Internal Backup Battery on page
44 for information on the operation of this unit.)

Problem Cause Solution
Low RF Output | Alarm Conditions => Check for alarm conditions and resolve, it
or No RF Output - necessary.

Strong, Out-of-Band = Check antenna orientation,

Inputs

Improper gain setting = __Check gain and reset, if necessary.

3. Activate the power source to the repeater, then turn ON the repeater's power switch (located in the —
upper left corner of the Entry Box). : .

NOTE: The power switch is also a magnetic sensing circuit breaker.

4. Connect the red lead (quick disconnect type) of the internal backup battery.

Confirming Proper System Voltage
You now must check the repeater, using RepeaterNet, to confirm proper system voltage.
To connect to the repeater and to confirm proper system voltage:
1. Plug the female end of the DB-9 serial cable into the serial port of the computer.
2. Plug the male end of the cable into the serial port located in the Entry Box.
3. Start RepeaterNet,

Start—>Programs->RepeaterNet->RepeaterNet

4. Ifthere is more than one repeater, select the appropriate from the list displayed to display the Main |
Control screen.

On the Login dialog box, enter a Login ID and Password.
Click OK to open the RepeaterNet Main Control screen.

Check the operation {color) of the Power subsystem (2-prong plug icon at the bottom of the
screen):

O Green—Normal Operation. Proceed to step 8.
O Red and flashing—Alarm Condition.
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information about resolving the alarm.

Configuration menu to open the Power System Properties
tarm, and see Table 17 on page 43 for

NOTE: Clear any active alarms before proceeding with the installation.

8. If there are no alarms, or after clearing active alarms, continue with the procedure in the following

section.

Checking that Power Amplifiers are OFF

All units are shipped with PAs tur
through it) displaying over each P
should remain OFF until you adjus

indicator, do the following:
1. Select Forward PA or Reverse PA from the Configuration menu to open the Properties window.
2. Click the Control tab.
3. Click the PA Power button to turn it OFF.
4. Click Apply or OK.

Determining the Correct Frequency

Consult the site plan or network engineeri
this application. In CDMA application
BTS with which the repeater is coord

s, primary and secondary assi

ned OFF as indicated by the PA OFF indicator (a circle with a slash
A subsystem icon (FPA or RPA) on the Main Control screen. PAs
t the gain. If any PA subsystem icon is not displaying the OFF

ng documentation for the proper channel or band settings for
gnments depend upon the Donor

inated. See the following table for a listing of CDMA channel

assignments. Note that Korea and Japan use different CDOMA channel assignments.

Table 15. Valid CDMA Channel No. to Frequency Cross Reference Chart /
Ffequency Quasi Channel | Official Channel | Base to Mobile ;:%wﬁ;bile
Block Number No. Forward (MHz) ard (MHz)
A 1 25 1851250~  1931.250
2 50 1852600 1932.500
3 75 _1853.750 1933.750
4 100 -~  1855.000 1935.000
5 v 1856.250 1936.250
6 _~ 150 1857.500 1937.500
7 175 1858.750 1938.70
B 200 1860.000 1940.000
9 225 1861.250 1941.250
10 250 1862.500 1942.500
/ 11 275 1863.750 1943.750

Qoguer ofColller  Chamnel Ne-> + Freg”-
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Frequency Quasi Channel Officlal Channel Base to Mobile Base to Mobile
Block Number No. Forward (MHz) Forward (MHz) A
B 1 425 1871.250 1951.250
2 450 1872.500 1952508
3 475 1873.750 1953750
4 500 1875.000 1955.000
5 525 1876.250 /1956.250
6 550 1877.500 /  1957.500
7 575 1878750 4 1958.750
8 600 1880.000 1960.000
9 625 1881.250” 1961.250
10 650 1882400 1962.500
11 675 1263.750 1963.750
c 1 925 _/1896.250 1976.250
2 950 /  1897.500 1977.500
3 975 /] 1898.750 1978.750
4 1000 1900.000 1980.000
5 1025/ 1901.250 1981.250
6 1950 1902.500 1982.500
7 /1075 1903.750 1983.750
8 /1100 1905.000 1985.000
9 / 1125 1906.250 1986.250
10 / 1150 1907.500 1987.500
1/ 1175 1908.750 1988.750
D 1,/ 325 1866.250 1946.250
P 350 1867.500 1947.500
/ 3 375 1868.750 1948.750
E / 1 725 1886.250 1966.250
4 2 750 1887.500 1967.500
/ 3 775 1888.750 1968.750
1 825 1891.250 1971.250
/ 2 850 1892.500 1972.500
3 875 1893.750 1973.750

Setting the Channel or Band

To set the operational channel or band:
Confirm that the repeater is ON and a direct connection has been established.

1.
2,

Configuring Gain Initially

When initially setting Forward and Reverse Gain, use th
or in network engineering documentation, (If necessary,
adjustments to gain settings are made during system op

From the Craft Main Contro! screen menu bar, sel
open the Channel 1 Properties screen.

ect Channel 1 from the Configuration menu to

On the Channel 1 Properties screen, click the Channel # tab.
Type the channel number in the Channel field to define a channel.

Click Apply or OK to set the channel.

e gain settings defined on the project site plan
contact your network administrator.) Final
timization.
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" To initially set gain:
1. Confirm that the repeater is ON and a direct connection has been established.

2. From the Craft Main Control screen, select Channel 1 from the Configuration menu to open the
Channel 1 Properties screen.

Click the Gain tab.

Click-drag each horizontal slider to define Forward and Reverse gain, noting that gain adjusts in 2
dB increments. The gain value box (centered under each slider) displays selected gain.

5. Click Apply or OK to set the gain and return to the Main'Control Screen.

NOTE: For 2-channel units, select Channel 2 and repeat steps 3 and 4 for the Channel 2 Forward and
.Reverse PAs.

Verifying and Optimizing the Coverage Area

For detailed information about repeater installation and link engineering, request the engineering
handbook, Instaliation, Operation, and Optimization of Over-the-Air Cellular and PCS Repeaters,
directly from Repeater Technologies.
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Chapter 7. Maintenance and Troubleshooting

The OA850C NR is a field-replaceable unit that requires no component-level repair. The use of highly
reliable components virtually eliminates maintenance. Routine checks of the OA850C NR and its
supporting equipment are recommended to ensure reliable operation and early detection of problems.

Routine Maintenance

Repeater Technologies recommends a semi-annual maintenance schedule for the repeater.
A procedure for routine maintenance follows:

1. Inspect the installation site and correct any problems.

2. Veﬁfy that the OA850C NR and all associated hardware, including antennas, is securely mounted
and properly in place.

3. Check input electrical wiring and BUPS for damage and ensure that connections are tight.
Check any battery terminals for corrosion; clean terminals, if necessary.

5. Clean solar panels and remove obstructions, if applicable.

CAUTION: Foflow manufacturers instructions when cleaning solar panels. Abrasive or
acetone-based solutions can cause damage to some types of panels.

Check antennas and coaxial cabling for damage and ensure that connections are tight.

Check the fins of the heatsink and clear any debris.

LEDs
The OA850C NR Entry Box displays four LED indicators—see the following table.

Table 16. Descriptions of LED Indicators

LED Indicator | Description LED Color Normal Trouble

Systermn Ready | Power ON Green On Off

Critical Alarm | Critical Alarm triggered Red Off On steady

Major Alarm Major Alarm triggered Red Off On steady

Minor Alarm Minor Alarm triggered Yellow Oft On steady
Troubleshooting

Perform all troubleshooting of the OA850C NR with RepeaterNet. See the following table for a listing of
common problems and possible solutions. ‘

NOTE: Contact the Repair Department of Repeater Technologies whenever problems with the unit can
not be resolved—see “Repair and Return Procedure.”
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Table 17. System Troubleshooting

Problem Cause Solution
Unable to Start Corrupted Program Data — Run the Scan Disk and Defragmenter utilities included
RepeaterNet with Windows 95.

Improper Installation of
RepeaterNet

Damaged Hard Drive

= Reinstall RepeaterNet.

= Repair or replace hard drive.

No Connection

improper COM Settings

Serial Cable Failure

Modem Failure

= Check telephbne number, COM pont, stop bits, parity
settings, and baud rate. Correct settings, if necessary.

— Check advanced settings from the COM Properties
screen. Reduce buffer sizes or disable buffer and retry
connection,

Check the cable for a tight connection.

Check the cable and connection ports for damage.
Replace cable, if necessary. Contact Repeater
Technologies if the connection portis damaged.

= Check telephone line connections at the computer and
the Repeater. Re-connect, if loose.

= Check telephone line for damage. Replacs, if
necessary.

= Login to a direct session with the Repeater and check
the modem and celi phone alarms. If either alarm is
active and does not clear, contact Repeater
Technologies.

= Check the computer's modem. Replace or repair
computer modem, if necessary.

L}

Overheating
(Temp. Alarm)

Insufficient Cooling

Check the heatsink. Clear any airflow obstructions.
Shade the unit if it is in an extremely hot environment.

I8

Low Voltage or Improper Solar Charging = Clean solar panels or remove obstructions. Do notuse
No Voitage an acetone-based solution for cleaning.
{Input Power Power Supply Failure = Check the condition of the power source.
Alarm) = Check all wiring and power leads to the power source.
= Check any fuses or circuit breakers in power supply
equipment.
= Check AC power service for outages or other service
problems.
Internal Power Converter | = Contact Repeater Technalogies to replace unit.
Failure
ALC Power Limit Gain tpcorrectly Set = Adjust gain.
Alarm PA Failure = Contact Repeater Technologies.
Low RF Output or | Controls Not Turned ON — Check to ensure Repeater power is ON and both PAs

No RF Qutput

Mobile or Base Antennas
Oriented Incorrectly

are turned ON.
— Check antenna orientation and re-align, if necessary.
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Problem Cause Solution
Low RF Output or | Alarm Conditions = Check for alarm conditions and resolve, if necessary.
No RF Output
Strong, Out-of-Band = Check antenna orientation.
inputs
Improper gain setting = Check gain and reset, if necessary.
Oscillation Active Alarm = Resolve alamm.
Foreground reflections = Remove object causing reflection; adjust antenna
orientation; move antenna mounting.
Improper Antenna = Clear area around antennas of excessive plant growth,
Isolation
Improper Gain Settings = Adjust gain.
Internal Backup Battery

The OA850C NR includes an internal backup battery to provide limited back-up power for the ACU
and, if applicable, the cell phone and internal modem. in the event of a loss of system power, the
internal battery provides power for the repeater to call out and report the failure, and to save the Alarm
and Event Log. The length of time that the internal battery provides power depends upon Repeater
configuration and environmental conditions (such as temperature).

Table 20. Internal Battery Backup Operation Estimales

Configuration

Operating Time*

transmitting

Repeater with no internal modem 5 hours
Repeater with internal modem and no ceil phone 2 hours
Repeater with internal modem and cell phone, with modem and phone continuously 20 minutes

*Values are astimates only: actual battery life may vary. Estimates assume a fully charged battery,
adverse environmental conditions, and a 600 mW AMPS cell phone.

System power charges the internal battery during normal operation. Note that the internal battery has a
low voltage cut-off to allow for a full recharge when power is restored.

If a power outage lasts longer than the operational limit of the internal battery, the modem cannot send
or receive calis, and Alarm and Event Log data is lost. Save the Alarm and Event Log when the
repeater calls out to report a system power failure—see “The System Menu” in RepeaterNet Craft for
the OA850C NR for more information about the Alarm and Event Log.

NOTES:

The internal battery does not provide power for RF transmission during a primary power outage.
Service is interrupted during a loss of primary system power,

The battery should be replaced on a 3-year cycle to allow for normal aging, wear, and
environmental deterioration.

a

a

OAB850C NR Operations Manual

Chapter 7. Maintenance and Troubleshooting — 44



Prefiminary Draft — RTi Confidential

Sparing Recommendation

Because repeaters are often used to provide critical coverage, customers are advised to follow a
sparing policy. While most carriers have intemal policies related to equipment sparing, in the event that
one does not exist, Repeater Technologies recommends that a carrier maintain a minimum of one (1)
spare unit for every increment of 10 units or fraction thereof. This assumes that all spares are
immediately available to the technician for installation. It is advised that each carrier develop a
company-specific, equipment-specific policy, one that accounts for geographic and environmental
factors and the total number of repeaters deployed in a given network.

Repair and Return Procedure

If a repair or return of the OA8B50C is necessary, contact the Repeater Technologies Customer Service
Department for instructions. Note that Customer Service needs the following information from you
when you call: .

0 A detailed explanation of the problem
@ The model name -
a The serial number of the unit

For equipment returns, a Repeater Technologies representative issues an RMA (Return Material
Authorization) and shipping and packaging instructions. When returning the OA850C NR, always use
the original shipping carton and packaging materials. If the original shipping materials are unavailable,
Repeater Technologies can send replacement materials at the cost of the purchaser.

CAUTION: If equipment is not returned to Repeater Technologies in the original packaging materials,
possible damage could result. Repeater Technologies is not liable for any damage
resulting from improper shipment.

Customer Service phones are staffed or monitored 24 hours a day, 7 days a week. Phone numbers for
the Customer Service Department are as follows:

(408) 747-1946
(800) 938-1901 {USA and Canada only}

Product Warranty

A one-year product warranty is provided with the OA1900 NR. A copy of the product warranty is
included with the Standard Terms and Conditions in every sales agreement. For more information,
contact the Repeater Technologies Customer Service Department.
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Glossary

This glossary defines communications indust

related
Repeat

A
AcCU
ALC
AMPS
BNC
BTS
BUPS

CDMA
c/E
ch

CPC
CRC
DAMPS

dB
dBc

dBi

dBm
DF, DFB
DVM
EM

EMI
ERP
F/B
FCC

FE
FIFC

Amp or Amps.

Atarm Control Unit.

Automatic Level Control.
Advanced Mobile Phone System.,

* Type of connector.

Base Transceiver Station.
Back-up Power Supply.

Code Division Multiple Access.
Carrier-to-Echo Ratio. -

Carrier-to-Interface Ratio. The ratio
between the mean signal level of the
desired radio signal and the signals
from other, interfering sources,
typically expressed in dB.

Circular Plastic Connector.
Cyclical Redundancy Check.

Digital Advanced Mobile Phone
System (equivalent of TDMA).

Decibel or decibels.

Decibels referenced to the carrier
level.

Decibels referenced to the isotropic
antenna,

Decibels referenced to one milliwatt.
Distributed Feedback (Laser).
Digital Voltmeter,

Electromagnetic.

Electromagnetic Interference.
Effective Radiated Power.
Front-to-Back Ratio.

Federal Communications
Commission (USA).

Front End.
First In First Out.

FORWARD
DIRECTION

FORWARD
GAIN

FRU
FSK
GSM

GuU

HAND-OFF

HOT TONE

microCell
MSC

MTSO

ry acronyms, symbols, and terms. Hardware- and software-
acronyms have also been included. As this glossary supplements all operations manuals of
er Technologies, not all items listed here necessarily appear in this manual.

Direction of transmission from the
base station through the Repeater
and on to Mobile or hand-held units.
Downlink transmission.

Gain setting for Forward
transmissions.

Field Replaceable Unit
Frequency-Shift Keying.

Globa! System for Mobile
Communications or Groupe Speciale
Mobile.

Graphical User Interface.

The act of transferring the service of
a call in progress on a cellular
systemn from one cell or sector to
another, typically also involving a
change in the voice channel used.

if a Mobile transmits at full power in
close proximity to a receive antenna,
a hot tone—for example, a receive
signal above -40 dBm—is produced.
Too hot a tone can over-modulate a
system and force it to drop all calls.
Systems designed to control reverse
attenuation will moderate the
potentially damaging effect of hot
tones,

Intermediate Frequency.
Intermodulation.
Intermodulation Distortion.
Light-emitting diode.

Low Noise Amplifier,

Local Oscillator, high-level input into
mixer.

Any small, low-power cell site.

Mobile Switching Center (equivalent
to MTSO).

Mobile Telephone Switching Office
(equivalent to MSC).
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MULTIPATH Radio propagation between a

NR
OoTU
PA
PCS
PSTN
PEP
PLL
Qccs
RBS

REVERSE
DIRECTION

transmitter and receiver where the
received signal is a compound of
multiple rays that have undergone
one or more reflections and/or
refractions. Cellular coverage is
most often provided in a multipath
environment, especially in high-
density city areas.

Network Repeater.

Optical Transceiver Unit.

. Power Amplifier.

Personal Communications Service.

Public Switched Telephone Network.

Peak Envelope Power. -

Phase Locked Loop.

Quick Connect Connecting Block.
Radio Base Station. See also BTS.

Direction of transmission from the
Mobile or portable through the
repeater and onto the RBS. Uplink
transmission.

REVERSE
GAIN

RF

RFI

RSL

RSA

RS5I

RX
SIMULCAST

SMA
SMB
TDMA

TSA

UHF
UPsS

VAC

vbC

VSWR

XPG

Gain setting for Reverse
transmissions.

Radic Frequency.

Radio Frequency Interference.
Receive Signal Level.

Rural Service Area.

Receive Signal-Strength Indicator.
Receive.

The process of transmitting the

same signal from two or more sites
simultaneously. |,
A type of connector.
A type of connector.

Time Division Multiple Access
(equivalent to DAMPS).

Traffic Service Area.

Transmit.

Ultra High Freguency.
Uninterruptable Power Supply.
Volt or Volts.

Voltage, Alternating Current.
Voltage, Direct Current.

Voltage to Standing Wave Ratio.
Watt or Watts.

Cross Polarization.

Craft for the OA850C NR
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Chapter 1. Installing RepeaterNet

This chapter briefly describes the componenits of the RepeaterNet software, identifies minimum system
requirements, and describes the installation procedure.

RepeaterNet Craft Software

The RepeaterNet Craft software (Craft} provides Windows 95- and Windows NT-based configuration
management and alarm monitoring for individual Repeater Technologies repeaters and dynamically
manages sessions in real time through one of these connections:

O A laptop computer with a direct connection to the repeaters—a technician can visit repeater sites and
connect to the repeaters directly using the serial port on the laptop.

O A laptop or desktop computer with a modem connection to the repeater—with the modem
connection, a technician need not visit the physical repeater sites to connect to the repeaters.

The Craft user interface varies, depending upon the model repeater being configured or monitored.

Minimum System Requirements

Craft system requirements include:

a  Pentium 120 MHz running Windows 95 with 32 MB of memory
a Approximately 10 MB of free disk space
o Modem (if a modem connection is to be used)

NOTES:

Q The Craft system must be used with Windows 95 with Service Pack 1 Update (Version 4.00.950 A) or
later releases or Windows NT, Service Pack 3 Update.

O Use “Hayes-compatible” modems only. “Connect with Rockwell” certified for modems of 56K and
above. US Robotics modems are not supported.

a #fyou use a fax program such as Microsoft Fax, make sure that the Auto Answer feature is disabled.
See Appendix D. Troubleshooting on page 38, Problem 7, for how to disable Auto Answer for
Microsoft Fax.

Installation Procedure
The OA850C NR Craft software is distributed on 4 HD fioppy disks. To install:

1. Insert Disk 1 in your a: drive.

2. From the Windows Start menu, select Run.

3. Type a:\setup and click on OK.

Follow the online instructions to install the Craft software.

Eal

The Craft software comes with default configuration files, which you can download to your repeater
according to the repeater type and number of channels. This eliminates the need to configure the
properties manually. See Download Properties on page 27.
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Chapter 2. RepeaterNet Craft —

Configuring the Repeater Connection

You must use the RepeaterNet Craft Admin program to configure the connection to the repeater before
you can access the RepeaterNet Craft software. Follow this path from the Start menu to invoke the
RepeaterNet Administrator:

Start -> Programs -> RepeaterNet Craft 2.2 -> RepeaterNet Craft Admin
When you invoke the Administrator, a window such as the following is displayed:

You can save both Direct and Dial-Out (Modem)
configurations, but remember to assign a unique COM Port
Number to each. Also, be sure to check Use this
connection for only one of the configurations. The COM PotNumber [T

connection checked is the connection RepeaterNet Craft

uses to connect to the repeater. W: Use this connection

For example, you may assign the connection type as Direct Modem Cormmaton
through COM Port 1. You can check the Use this
connection box to make this your default configuration. COMPottimber 0]

Click on Save. Phone Number L.Nwm._w !

I3 Use this connection

Next, you can save a Modem configuration to another COM
port, such as COM Port 2:

1. Assign a COM Port Number that is different from the
COM Port Number used for Direct connection. & Unlitled - Repeateihiet
Ele Edt View liel

2. Click on Save, then click on OK to exit RepeaterNet
Admin.
Starting Craft

Double-click the Craft icon to display this window.
RepeaterNet connects to the repeater and displays the Craft
Main Control screen for the QA850C NR.

OAB850C NR Craft Main Control Screen

The Craft Main Control screen provides access to all monitor
and control functions of the OA850C Network Repeater (NR).

Connecting o Repeater... K
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Main Control screen icons (labeled on the following screen) provide access to subsystem status screens

and report alarms.

| ;' CDMA Repeater

File Conliguiation

System QOptions

Help

E—— |

Forward Channel 1
Front End Forward
Power
Channel 1 Amuolifiar
Forward Channel
Select Filter Channel 2
. Forward
Channel 2 Power
Forward Amplifier
Channel Select
Fiktar Channel 1
. Reverse Channel
Channel 1 Select Fllter
Reverse Power Reverse Front End
Amplifier i
i Diversity Front End
Channel 2
Reverse !
Power % Channel 2
Amalifier ; Reverse Channel
% Select Filter
|
i
i
|

Alarm Slalxoi the Alarm C$’ltl0| Unit. T 7 NT 1Te 4
|

i |
Alarm Control Modem  Cell Phone Power Back-up Power

Unit Supply

OAB850C NR Craft Main Control Screen

NOTES:

a Al units are shipped with PAs turned OFF as indicated by the PA OFF indicator (a circle with a slash
through it) displaying over each PA subsystem icon (FPA and RPA). PAs should remain OFF until

gain is adjusted.

@ The Main Control screen displays differently depending on the hardware configuration of the unit. For
example, Channel 2 icons are grayed-out (unavailable) for a single-channel repealer.
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Configuration

Configure the OA850C NR on subsystem Properties screens, which you can display from the Craft
Configuration menu.

The Configuration menu contains the following:

Front End.......ouvveeeoeo Forward, Reverse, and Diversity
Channel 1..........ocoovervvi Available on all units
Channel 2...........coooverv Available on 2-channel units only
Alarm Control Unit............... ACU '
Modem ..........cveeeveemn, Internal or external modem option
Cellular phone...................... Cellular option only

. Power System ..................... Input, battery, and internal
UPS ..o Backup power system

Status Reporting

Once you have configured the repeater, you can monitor and control repeater system functions on
subsystem Status screens. Click a subsystem icon to open its status screen.

When an alarm is triggered, the subsystem icon changes appearance, blinks, and activates an audible
alarm. Clicking on the icon and viewing the subsystem status screen stops the blinking and the audible
alarm. The display of the icon does not revert to normal until the alarm condition is cleared.

The display of the Forward PA and Reverse PA icons also indicate the operational status of the PAs. If a
PA is OFF, a circle with a slash is displayed over the associated icon.

When RepeaterNet displays a subsystem as disabled, that subsystem is not available to the repeater. For
example, in repeaters without a cellular phone, the cellular icon is displayed in light gray.

Alarm Status Reporting on the Main Control Screen

RepeaterNet uses a color system to report subsystem alarm status on the Main Control screen.

The meanings of the colors, and color independent icons, is shown in the following table,

Subsystem Alarm Status lcon Color Color Independing Icon Action
Normal—No Alarm Green N/A N/A
Critical Alarm Red X Call Out
Major Alarm Yellow \ Call Qut
Minor Alarm Blue Call Out
Event White None None
Disabled Dark Gray* N/A None
System Not Available Light Gray N/A N/A

* When all alarms in an individual subsystem are disabled or set to event severity, the icon color is displayed in
dark gray.
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When an alarm is triggered, the icon color of the affected subsystem changes from green (normal) to the
color of the alarm definition, and the icon blinks.

RepeaterNet also offers two optional alarm features:
o Color Independent Icons is provided for operators unable to distinguish colors

g Alarm Sounds adds an audible alarm

Should more than one alarm within an individual subsystem be triggered, the higher severity alarm is
reported on the Main Control screen. .

For example, if both a major and a miror Reverse PA alarm triggers, a yellow subsystem icon is reported.
If the major alarm is cleared while the minor alarm remains active, a blue subsystem icon is reported.
Color-independent icons also report the higher severity alarm, should more than one alarm on an individual
subsystem be triggered.

NOTE: When an subsystem alarm is triggered, click the icon (to open the status screen) to terminate the
icon blinking feature and silence the audible alarm. Icon color continues to report and a color
independent icon (if applicable) continues to display until the alarm is cleared. Color reporting does
not apply to subsystems set to Event severity.

Defining Alarm Severity

The OA850C NR is factory-configured with a standard set of alarm severity settings. Adjust alarm severity
on the subsystem Properties screens. See Chapter 3. Configuring OA850C NR Properties on page 10
for more information about alarm severity and the factory configuration.

The levels of alarm severity are:

@ Critical
a  Major

0 Minor

o Event

O Disabled

To define alarm severity:
1. Login to a session with the repeater.

2. Select Configuration from the Main Control menu bar, then select a subsystem to open its Properties
screen. For example, select Configuration -> Channel 1.

The Alarms tab is displayed.
1. Click the down-arrow next to an Alarm field to select a new alarm severity.

2. Click Apply or OK.

Craft for the OA850C NR Chapter 2. RepeaterNet Craft — Page 9
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Chapter 3. Configuring OA850C NR Properties —

Use the subsystem Properties screens to perform configuration of the repeater. To open a Properties
screen, select a subsystem from the Configuration menu.

Front End
Channel 1
Channel 2

Alarm Control Unit
Modem

Cellular Phone
Power System
UPS

The Properties screens display tabs specific to each subsystem. Some subsystem Properties screens
include tabs for redefining alarm severity and specifying operational settings; others have a single tab for
redefining alarm severity.

goooooocgo

Configuration includes: Fromend &

o Redefining alarm severity Femward FE | Reverse FE | Diversiy FE | Diversty FE Gain |

o  Specifying operational settings for the prrems pev Toovsty |

&
repeater : FdFE_ Alam Props Maior 3|

Front End Properties
The Front End Properties screen lets you
configure the Front End subsystems. This screen -
includes tabs that let you set the alarm severity
for:

o Forward FE

o Reverse FE

o Diversity FE ok ] conel | |  Hew |
Forward FE Tab __________——I
The Forward FE tab lets you set the alarm _ o ,
severity of the Forward FE alarm. The Forward Forwad FE. oveseE | Diverty | Divecsiy FE G|
FE alarm is activated when the forward signal Ao Doscrglion [Soverty
power level is too strong and is being attenuated gﬁg NmPAm N :‘w -
to protect the repeater from possible damage. Frotect b ™
NOTE: Do not adjust power amplifier gain while

this alarm is aclive.

Reverse FE Tab
The Reverse FE tab lets you set the alarm
severity of the Reverse FE alarm. The Reverse
FE alarm is activated when the reverse signal
power level is too strong and is being attenuated x| Coeel | - | Hep |
to protect the repeater from possible damage.
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NOTE: Do not adjust power amplifier gain while this alarm is active.

Diversity FE Tab

The Diversity FE tab lets you set the alarm severity
of the Diversity FE Alarm and set the gain of the
Diversity receiver.

The Diversity FE alarm is activated when the
Diversity Receive signal power level is too strong
and is being attenuated to protect the repeater from
possible damage.

NOTE: Do not adjust power amplifier gain while
this alarm is active.

Diversity FE Gain Tab

Gain must be carefully balanced in any application

Fosward FE | Reverse FE  Diversiy FE | Diversity FE Gain|
Alam Description | seveity
Divetsity FE Alam Props Minor -
[ ok | cuncs | C| he ]

to ensure proper hand-off and system operation. Note that RepeaterNet detects the configuration of the
repeater and displays the applicable gain range on the Diversity FE Gain tab. You can adjust the Diversity

FE gain. The adjustable gain range depends upon
the type of repeater you are using and the power
level of the power amplifiers.

To adjust Diversity FE gain:

1. Select Configuration ->Front End to open the
Front End Properties screen.

2. Click the Diversity FE Gain tab.

3. Click-drag the horizontal sliders to define
forward and reverse gain, noting that gain
adjusts in 2 dB increments. The gain value box
(centered under slider) displays selected gain.

4. Click Apply or OK.

Channel Properties

[Fromtgra — K

Formard FE | Reverse FE | Diversty FE  Diversiy FE Gan ]

Gain
o
() 3] 1] 1548
[ ok ] cexe | . ] e ]

From the Main Control screen menu bar, select Channel 1 or Channel 2 (for 2-channel units only) to open

a Channel Properties screen.

Channel properties include:

Reverse PA
Forward PA
PA Control
Reverse Filter
Forward Filter
Channel #
Gain

ocoo0o0oDg
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Channel Reverse PA Tab

The Reverse PA tab shows the most recent alarm state, including severity, date, and time, for these

alarms:

PA Alarm
Indicates a component failure in the power
amplifier; the repeater is inoperative.

VSWR Alarm
Indicates a problem with the Voltage to
Standing Wave Ratio.

Thermal Alarm
Indicates the system temperature has
exceeded the alarm threshold. The
repeater has been shut down. When the
temperature falls below subsystem
tolerances, the repeater automatically
reactivates the PA.

External Shutdown Alarm
Indicates that the repeater has been shut
down by a user; also activates one RPA
alarm.

1Channet 1 Properties

Rev. PA | Fd, P2} PA Conrol | Fiev. Fter | Fwd Fiter | Chanvel # ] Gain |

Alatm Descripion f Savari

RevPA1 Alarm Event -
RevPA1 VSWR Alam Minos -
RevPAT Theimal Alwm Major -
RevPAl Ext Shutdown Alam Critical -

[ox ] coawd f| aoob

Redefine alarm severity for the Reverse PA subsystem on this tab.

1. Click the down-arrow next to an Alarm field to select a new alarm severity.

2. Click Apply or OK.

See Forward PA for a sample screen.

Channel Forward PA Tab

The Forward PA tab shows the most recent
alarm state, including severity, date, and time,
for these alarms: .

PA Alarm
Indicates a component failure in the power
amplifier; the repeater is inoperative.

VSWRA Alarm
Indicates a problem with the Voltage to
Standing Wave Ratio.

Thermal Alarm
Indicates the system temperature has
exceeded the alarm threshold. The
repeater has been shut down. When the

temperature falls below subsystem tolerances,

External Shutdown Alarm

Channel 1 Psopethes

g_gw.PA]Fwd.PA[Pacwdlaw.mpwctrau}mma[am |

Alarm Description IS

FwdPAT Alam Event v
FwdPA1 VSWR Alarm Event -
FwdPAT Theimal Alaim Major v
FwdPAl Ext Shutdown Alam Disabled -

[ ][ e [ oo |

the repeater automatically reactivates the PA.

indicates that the repeater has been shut down by a user; also activates one RPA alarm.

Craft for the OA850C NR
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Redefine alarm severity for the Forward PA
subsystem on this tab.

1. Click the down-arrow next to an Alarm field to
select a new alarm severity.
2. Click Apply or OK

Channel PA Control Tab

The PA Control tab provides a switch to turn PA
power ON or OFF.

1. Click on ON or OFF in the PA Power box to
change the value.

2. Click Apply or OK for the setting to take effect.

Channel Reverse Filter Tab

This tab displays the most recent alarm state for a
single channel select filter alarm. A failure in the
Reverse Filter assembly triggers an alarm and the
filter becomes inoperative.

Redefine alarm severity for the Reverse Filter
subsystem on this tab.

1. Click the down-arrow next to an Alarm field to
select a new alarm severity.

2. Click Apply or OK

Values are Disabled, Event, Minor, Major, and
Critical.

See Forward Filter for a screen example.

Channel Forward Filtér Tab

This tab displays the most recent alarm state for a
single channel select filter alarm. A failure in the
Forward Filter assembly triggers an alarm and the
filter becomes inoperative.

Redefine alarm severity for the Forward Fiiter
subsystem on this tab.

1. Click the down-arrow next to an Alarm field to
select a new alarm severity.

2. Click Apply or OK.

Values are Disabled, Event, Minor, Major, and
Critical.

{Fiev. PA | Fwd PA | PA Contial | Rev. Fiter | Fwd Fiter] Chenval it ] Gan |

Reverss PA Power—

Channel 1 Properties

{Hw.FAEFud.PA]PACorlrd}RW-RNIFwdFquMﬂ[E&\ |
Alarm Descripty | Severity
C5F1 RevAlsm Winor -
i
T F s L

N |

[Fiow, PA| Fwd. PA | PA Cartrol | Rev, Fiter | Fed Fiter [Thamnel ] Gan |
Alarm Descrpt } Seventy
TSF Fwd Alem Hinor -
I I N
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Channel # Tab

The Channel # tab lets you set the operating channel
or band for Channel 1 or Channe! 2. Once you select
a channel, the corresponding frequencies are
displayed. Consult your network administrator or the
system Site Pian for the proper channel or band
setting.

Channel Gain Tab

RepeaterNet detects the configuration of the repeater
and displays the applicable gain range on the Gain
tab. You can adjust Forward and Reverse gain for
the selected channel.

The adjustable gain range depends upon the type of

"Frav. PA | Fud. PA] PAContdl | Rav, Fite J Fnct Fiter | Channel # ]E;; |
Chanriel Number | I
Forward Frequancy (MHz) (197055 1
Revesse Frequency [MHz) 1183055 ;
. Mastmunm Channel H
Channel Spacing (KHz)
LK ][ Concd ] oy ]

repeater you are using and the power level of the power amplifiers. RepeaterNet limits gain adjustment to

valid selections only.

NOTE: Set gain for the Diversity Receiver on the
Diversity FE tab of the Front End Properties
Screen.

Gain must be carefully balanced in any application to
ensure proper hand-off and system operation.

To adjust Forward PA or Reverse PA gain:

1. Select Configuration ->Channel 1 or Channel
2 to open the Channel Properties screen.

2. Click the Gain tab.

3. Click-drag the horizontal sliders to define forward
and reverse gain, noting that gain adjusts in
2 dB increments. The gain value box (centered
under each slider) displays selected gain.

4. Click Apply or OK.

ACU Properties

’lnw.m[ Frud PA | PA Contdlf Rev. Fier | Fd Fier | Charral 8] Gom |

¢ Forward

Select Alarm Control Unit from the Main Control screen Configuration menu to open the ACU
Properties screen. This screen includes tables for YO Descriptions, /0O Control, Alarms, and DC

Voltage Alarm Threshold.

The ACU subsystem provides alarm and control functions for the repeater. The ACU moniters all the
repeater subsystems and reports status to a connection device or to remote devices through a dial-up

modem connection. In addition to monitoring the repeate
inputs and outputs to monitor and control external device

Inputs and Outputs

r system, the ACU contains a number of external

5.

RepeaterNet lets you monitor two digital aiarm inputs and one DC voltage input from external devices. You
also can activate up to four external devices with two relay outputs and two digital outputs,
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NOTE: Alarm settings for digital input 1 and digital input 2 are initially set to Disabled.

The inputs and outputs are as follows:

Relay Qutputs 1 and 2
The two relay outputs are configured with three leads in a Form C Contact Closure, with normally
closed and common connectors closed with the switch in the OFF position and normally open and
common connectors closed with the switch in the ON position.

Digital Qutputs 1 and 2 .
The two digital outputs each have two leads that provide an opto-isolated circuit that presents a low
impedance connection when the switch is in the ON position and a high impedance connection when
the switch is in the OFF position.

Digital Inputs 1 and 2
The two digital inputs each have leads that generate an alarm condition if the leads form a low
impedance circuit {a closed contact), and a clear condition if the leads form a high impedance circuit
(an open circuit).

For information about connecting inputs and Alaim Contiol Uni_Fiopertics
outputs to the repeater, see the OA850C NR 170 Descriptions | 170 Conirois | Adams | Ext. DC Vokags |
Oparations Manual. Enterthe dasciipions for s devics's inputs and outputs

. . Dutputs
ACU I/O Descriptions Tab b ] oo
Label external equipment connected to the Reley 2 [———J.N Digital
repeater’s inputs and outputs using the /O . ) m

Descriptions tab. External equipment could be a

Inputs:

security light or any other site equipment. bC @j R
To add O Descriptions: Digedl 2 W_“l
1. Select Configuration->Alarm Control Unit to
open the ACU Properties screen. The I/O x| & ]

Descriptions tab is active.

2. Provide I/O Descriptions in available data fields. m Control Unit Propettics R |
iy

3. Click Apply or OK. {0 Desorptions |170 Cortids | Alams | Ext DC Vokegs |

ACU I/O Controls Tab Relay Duputs ey 1 Dighal DULpLg ooy

The I/O Controis tab contains switches to turn Relay
Outputs and Digital Outputs for channels 1 and 2 ON
or OFF.

See Inputs and Outputs.

Lo ][ Coeel ][ eow |

Craft for the OA850C NR Chapler 3. Configuring OA850C NR Properties — Page 15




Prefiminary Draft — ATl Confidential

A CU Alarms sefﬁng Tab Alaim Contiol Unit Praperlics
170 Descriptions § 1/0 Conkols | Alams [ DT Vokage |
Redefine aiarm severity for ACU subsystems on the i — — T
Alarms Settings tab. Ext Irgaa] Adam Fo ~
Ext. Input2 Alarm Mo ~
1. Click the down-arrow next to an Alarm field to Uk dorrilt E:.,'f' :
select a new alarm severity. potvec st NN o M
2. Click Apply or OK.
Values are Disabled, Event, Minor, Major, and Critical.
. oK i Concel Apply
ACU DC Voltage Alarm Threshold Tab E } L& |

RepeaterNet can monitor an external DC voltage power source (a battery) in a range of 0 to 60 volts in 250
mV increments. In addition to monitoring the voltage level, you can define upper and lower limits for the
voltage that is to activate the DC Voltage alarm in the ACU subsystem.

Monitor the voltage of a DC power source (supplied :
by you) used to power external site equipment using Atarm Eontio! Unit Pioperies

the DC Voltage Alarm Threshold tab. An alarm is 1170 Deserpitons | 170 Controks | Alame | . BC Vokage | e
triggered if the voltage fluctuates from a defined i
operating range. © Definethe mitum and masinun values the tioges the Exemal DC
To define an operating range for DC voltage: 5 O Vekege
E Less E 3:
1. Select Configuration->Alarm Control Unit to / G o5

open the ACU Properties screen.
2. Click the DC Voltage Alarm Threshold tab.

3. Define (type in or arrow-click) the normal
operating range for the DC power source in the
Less Than and Greater Than data fields. L Ok ) Concd |7 oy |

4. Click Apply or OK,

Modem Properties

From the Main Control screen menu bar, select Configuration->Modem to open the Modem Properties
screen. This screen has three tabs:

Alarm Setting
Lets you set the alarm severity for the Modem alarm. This alarm indicates a failure of the internal
modem.

Modem Setting
Lets you define the port settings for the internal or external modem.

Pager Setting
Lets you configure a pager to be notified when a certain severity level alarm occurs.

Craft for the OA850C NR Chapter 3. Configuring OA850C NR Properties — Page 16




Preliminary Draft — RT! Confidenlial

Alarm Setting

Use the Alarm Setting tab to redefine alarm severity for | AlumsSetng [Modem Seting] Pager Seting |
the repeater's modem.

Alam Descrigtion § Seveity
Modem Alam Minot -

1. Click the down-arrow next to an Alarm field to select
a new alarm severity.

2. Click Apply or OK.

Values are Disabled, Event, Minor, Major, and Critical.

Modem Setting

Define modem settings for the repeater's modem using
the Modem Properties tab.

R

To define modem settings:

1. Select Modem from the Main Control screen Configuration menu to open the Modem Properties
screen.

2. Click the Modem Settings tab. Modem Properties Eil

3. Define the Setup String, Phone Number, and Blome Setng Modem Setig | P St

Call Attempts. Setup Sting £

) PhoneNumber [0
4. Click Apply or OK. Cal Attompts: T

Setup String is reserved for configuring a cell phone BadRate s d

or modem. The cellular phone setup string is $37=6. Pasity None =

Phone Number is the phone number of a remote Date 8 p ol Tvpe
computer to be called. This value is 0 unless you are 1 j & Lame
using RepeaterNet Network Management software or “e | e

other network management software.

[nchm]gm_]

Call Attempts is the number of caliout attempts before
disconnecting; a zero (0) disables calling.

Baud Rate is the communication speed between the modem and cell phone (which must be greater than
2400). Baud Rate is adjusted automatically downwards by the modem when necessary.

Set Parity to None. Parity must be set the same as the computer's modem.
Set Data Bits to 8. Data Bits must be set the same as the computers modem.

Set Dial Type to Tone,

Over-the-Air Repeater Modem Setup

If an external wireless interface (such as the Telular) is connected to an OA (Over-the-Air) repeater, you
must properly configure the repeater's modem. if the modem is not properly set up, few if any of the calls
to the repeater wili be successful.

To properly set up your modem for all Repeater Technologies OA products (including the OABCO, OAB850,
and OA1900):

1. Connect to the repeater through the local Craft port.
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Launch RepeaterNet.

w

Once the connection to the repeater has been established, select Configuration from menu bar at the
top of the screen.

From the Configuration menu, select Modem Properties.
Click on the Modem Setting tab.
Enter S37=6 in the Modem Init String field (the top field on the Modem tab).

Nooe o ok

Enter a Phone Number; for example 9, (222) 123-4567. Each comma creates a 2-second delay in
dialing. Parentheses () and spaces are ignored.

8. Enter the number of times you want RepeaterNet to attempt to make the connection; for example, 3; 0
(zero) in this field disables calling.

9. Click on Apply or OK at the bottom of the window.

This procedure forces the repeater to initialize the modem to 2400 baud, which improves the connection on
analog wireless networks.

Changes made to the default settings on the Modem Properties screen take effect upon exiting
RepeaterNet.

In addition:

O  If you configure a repeater to automatically call out and report alarm status, the repeater COM port
settings must match the settings of the modem to be called.

o For users to log in to the repeater with a modem, the port settings of their computer's modem (defined
in the configuration file) must match the settings of the repeater modem.

Q Ifthe repeater is equipped with an internal modem, the setup string is controlled automatically by the
repeater's hardware. If the repeater is connected to an externa! modem, consult the modem’s
documentation for the setup string.

o Changes you mgke to the defauit settings on t.h_e
I;l:gz;?et’rzc;p:.emes screen take effect upon exiting s Sats | Viedom Sating] PogrSo |

Pager Setting Pages Nurber | =

You can set BepeaterNet to send out a page when a Call Attompts: |

gz:;tt?rgs;\snty level alarm occurs with the Pager BepesteNumbsr [ ]

Mirium Alarm Severity:
A page is generated if the summary alarm severity is
greater than or equal to the Minimum Severity you :
select. When a page request is detected, the repeater
terminates any current modem connection and
generates a page. The page format consists of the
repeater numbegr followed by the severity level, for [ox J[ coeel J o |
example, 123456-2.

If a change in the current alarm severity is detected, note the following:

Q  If the Minimum Severity is set to Major and a Major alarm comes in, a page with a severity of 2 is
generated.
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If a Critical alarm is detected, page is generated again with a severity of 3 (Critical plus Major).

If the Major alarm is cleared but the Critical alarm remains, a page is generated with a severity of 1
{Critical)

If the Critical alarm is cleared, a page is generated with a severity of 0.
If a Minor alarm is detected, no page is generated because the Minimum Severity is set to Major.

Events do not generate a page.

Severity numbers are:

No Alarms 0 Minor 4
Critical 1 Critical + Minor 5
Major 2 Major + Minor 6
Critical + Major 3 Critical + Major + Minor 7

To set a pager:

1.
2.

Click on the Pager Setting tab of the Modemn Properties screen.

Enter the Pager Number, the number of times RepeaterNet should attempt to call the pager number
(Call Attempts), and the number of the repeater (Repeater Number).

The Pager Number is the phone number to be called. This reflects the pager phone number,
including networking access number (9), 1, and area code (if needed). Access the network dial
number and wait 5 seconds before sending the page sequence.

Several commas must follow the phone number—each comma generates a delay of 1 second.
Generally, it takes about 3 seconds for the pager company to pick up the line, and a maximum of 5
seconds before they drop the connection. A good delay would be 5 seconds, in which case you would
add 5 commas; for example, 9 1 (408) 555-1212,,,,, . Spaces, dashes, and parentheses are ignored.

Enter the Call Attempts, which are the number of retry calls to be attempted. A value of 0 in this field
disables paging.

Enter the Repeater Number (a system identification number or description).
Select the minimum alarm severity for paging. Values can be Critical, Major, or Minor.

Click on Apply to set the values without exiting the properties screen; click on OK to set the values and
exit.

Cell Phone Properties

£rom the Main Control screen Configuration
menu, select Cellular Phone to open the Cell T P Y Seveiy
Phone Properties screen. PCS Phone Al Max v

The Alarms tab lets you set the alarm severity for
the Cellular Alarm. This alarm indicates a failure of
a cellular phone.

To change alarm severity:

1.

Alsims Selting

Click the down-arrow next to an Alarm field to
select a new alarm severity. o ][ cocd [ o]
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1. Click the down-arrow next to an Alarm field to select a new alarm severity.
2. Click Apply or OK.

Severity levels include Disabled, Event, Minor, Major, and Critical.

NOTE: This severity should be minor. The Cell Phone alarm is generated when the cell phone faifs to
report an alarm after all retry attempts by either the modem or the pager. This alarm clears when
the cell phone succeeds in reporting an alarm.

When there is no ceil phone, the Cell Properties selection is disabled.

Power System Properties N

From the Main Control screen Configuration menu, |Maldatlelallis

select Power System to open the Power System Alams Setting

Properties screen. This screen lets you access initial —

configuration settings for the power subsystem. .“L’”fxm l%%::b -
Povser Supply Alarm Mq_'or -

Redefine alarm severity for Power systems using the PS Battery Alam Mejor v

Alarms Setting tab.

1. Click the down-arrow next to an Alarm field to
select a new alarm severity. ‘

2. Click Apply or OK.

Values are Disabled, Event, Minor, Major, and 6 | Cod [ aos |
Critical.

The Alarm Setting tab lets you set the alarm severity of the following alarms:

Input Power Alarm
The input power to the repeater is out of system tolerances.

Power Supply Alarm
The internal system power of the repeater is out of tolerances.

Battery Alarm
The voltage of the internal battery is below tolerances. This battery supplies power to the ACU,
modem, and ceill phone in the event of a system power failure, letting the repeater call out and report
its status. It also supplies power to the memory that stores the Alarm and Event Log.

Battery Charger Alarm
The internal battery charger is not charging the internal battery.

NOTE: The internal battery does not provide power for RF components and the repeater will not be able to
provide RF coverage during a power failure.
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Backup Power System (UPS) Properties

The UPS Propetrties screen lets you access initial configuration settings for the optional, external backup
power supply.

From the Main Control screen menu bar, select :
" . ! . Alarms Setting |
Configuration -> UPS to open the UPS Properties ”
screen. Alarem Description __ Sevedy
AL Fal Alaim Critical -
Redefine alarm seveiity for backup power systems e i :
using the Alarms Setting tab. mﬁm o T
1. Click the down-arrow next to an Alarm field to o fom e iy
select a new alarm severity.
2. Click Apply or OK.
Values are Disabled, Event, Minor, Major, and R

Critical.

You can set the severity for the following alarms:

AC Fail Alarm
Indicates that the input power to the BUPS has failed. In this case, the BUPS provides 40 or 80 amp-
hours {depending upon which BUPS model is installed) of backup power for the repeater before
shutdown. (The AC source powers the charger.)

Battery Low Alarm
Indicates that battery voltage of the BUPS is below operating tolerances and the BUPS cannot power
the repeater.

Battery High Alarm
Indicates that battery voltage of the BUPS is above operating tolerances and the BUPS cannot power
the repeater.

Charge Fail Alarm
Indicates that the internal charger of the BUPS has failed and the BUPS is unable to recharge its
batteries.

Summary Alarm
Indicates that one or more of the BUPS alarms have been triggered.

Tamper Alarm
Indicates that the door of the BUPS is open.
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Chapter 4. Monitoring OA850C NR Status

Monitor and control repeater system functions on subsystem Status screens. Click a subsystem icon to
open its Status screen,

Each Status screen includes one or more of the following tabs:

Alarms
Reports present subsystem alarm states, with date and time stamps.

Measurements
Reports power and operational temperature measurements, including Low and High values. A Reset
Low/High button resets values.

Voltages
Reports present voltages for a subsystem.

Control
Includes ON/OFF switches for internal and external subsystem hardware.

Status screens for the OA850C NR are:

0

Q

Front End Status

Channel Status

™ Filter Status (Forward and Reverse)

™ PA Status (Forward and Reverse) Forewnd Frond £nd Statas
=  Alarm Control Unit (ACU) Status al
= Modem Status Dezcrp ot Do Toe
=  Cellular Phone Status Hom et O R
=  Power System Status
= UPS Status
Front End Status
Click an FFE (Forward Front End) icon to display the [ Coed |

Front End Status screen. The Front End Status screen

Alarm tab reports these alarms:

Forward FE alarm
Activated when the forward signal power level is
too strong and is being attenuated to protect the
repeater from possible damage.

Reverse FE alarm
Activated when the reverse signal power level is
too strong and is being attenuated to protect the
repeater from possible damages.

Beverse bront End Status

e
RuevfE Alam Stahus
AnsFE Protect Alwm Siabus

Statue

Dale

Jan 01, 2000
Jan 01, 2000

Tire
120000 AM
120000 AM

[ Coed ]
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Diversity FE alarm
Activated when the Diversity Receive signal power
level is too strong and is being attenuated to protect
the repeater from possible damage.

Channel Filter Status

Click a Channel 1 or Channel 2 filter icon (sine waves) to

open a filter Status screen, which reports a CSF1
Forward Alarm (Forward Filter) and CSF1 Reverse
Alarm (Reverse Filter) with date and time stamps.
A failure in the Reverse or Forward filter assembly

triggers an alarm.

Channel PA Status

Ciick a Channel 1 or Channel 2 FPA or RPA icon to
open a PA Status screen.

PA Alarm Tab

The PA Alarms tab reports subsystem alarms with
date and time stamps: A failure in the Forward or
Reverse PA assembly triggers an alarm.

PA Measurement Tab

The Channel 1 and Channel 2 PA Measurement tabs
reports the output power of the repeater, including low
and high output values. To reset low and high output
values, click Reset Low/High.

ACU Status

Click the ACU icon to open the ACU Status screen.
There are two tabs—Alarm and Measurement.

Diversity Front End Status [ x]
Alam l
o Dascietin | s | Dow | Tee |
Divessiy FE Alam Stahut D Ap 24,139 Ot 18:20 AM
el J_he |
e |
Descrpt Stag Dals Time
CSF Frvd Alerm Status Jan 01, 2000 120000 AM

e T

D i Status Datw Time
FedPAT Alarm Statui Jan Ot, 2000 12 00:00 &M
FwdPAT VSWR Alarit Status Jan 91, 2000 1200:00 M
FwdPa1 Themmal Alarm Status Jan 01, 2060 1200:00 AM
FrcPA Ent Shutdown Alam St.. Jan 01,2000 1200:00 Ak
{ tacd ]

[Channet 1 Forwad PA 5 tatas

o] e |
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ACU Alarm _

The Alarm tab reports subsystem alarms with date _

and time stamps. A failure in the ACU assembly “‘t'““‘:.”f’".ms':“ @ 05% j,%‘f%% :gé“;ém

triggers an alarm. ELimizien o 0 e 1zmopa
Lﬂ.ﬁm‘m @ Dinabledd i:%ﬁ Egﬁm

The ACU alarms include: A e o o Skt [NMENIEINR Jon 07,2000 1200.00AM

External Input Alarms (1 and 2)

An alarm generated from optional, external

equipment,
o o |

Temperature Alarm

The system temperature threshold has been

exceeded.
Tamper Alarm

The repeater door is open. ey e WTT ST 5
Analog Input Alarm o Ve 60 ac 50| Peulowiio]

The upper or lower limits for monitoring of the
analog input DC voltage source have been
exceeded.

Measurement

[

The Measurement tab reports current, low, angd high
system temperature and DC voltage source values.

Click on the Reset Low/High button to reset the low and ’M
high values. T | ‘
: | Sere DSnI:::d l51."24:31: 12;:.';m

Alaath i an 01, i
Modem Status e ' |
Click the Modem icon to open the Modem Status i
screen, which reports a2 modem alarm with a date and !
time stamp. Internal modem component failure triggers ) B |
an alarm.

e Lo |

Cell Phone Status {_
S

Click the Cell Phone icon to open the Cell Phone
Status screen, which reports a Cell Phone Alarm with a [y S Das T

date and time stamp. Internal cellular phone Fhone Rem s Tk
component failure triggers an alarm.
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Power System Status

Click the Power icon to open the Power System Status screen. This screen allows access to monitoring
and operating tasks for the repeater’s power subsystem.

Alarm
The Alarms tab reports the status of the e | Vokages |
following alarms with severity, date, and time . o _
information for each: = ke I L
Fowet Supply Alwm Status Jan (71, 2000 120000 AM
|nput Power A‘arm PS Battery Alsim Status Jan (1, 2000 12.00:00 AM
Indicates the input power to the repeater is
out of tolerances.
Power Supply Alarm
Indicates system power of the repeater is
out of tolerances.
ok ]| Cacd |
Battery Alarm

indicates the voltage of the internal battery is out of tolerances. This battery supplies power to the
ACU, modem, and cellutar phone in the event of a system power failure, letting the repeater call out
and report its status. It also supplies power to the memory that stores the Alarm and Event Log.

Battery Charger Alarm
Indicates that the internal battery charger is not charging the internal battery.

NOTE: The internal battery does not provide _|

power ‘- RF ccnonents and the [ Kl { Vohages |
repeater will not i » able to provide RF {
coverage during a ~ower failure. Descrption T Vokage
PS Battery Vols i3]
PS Volts 00
Voltages

The Voltages tab shows the current power
values for Battery Volts, Channe! 1 PA Volts,
and Channel 2 PA volts.

UPS Status

The UPS Status screen allows access monitoring of the optional, external backup power supply.

This screen includes an Alarms tab, which displays the alarm status of the following alarms:

AC Fail Atarm
Indicates that the input power to the BUPS has failed. In this case, the BUPS provides 40 or 80 amp-

hours (depending upon which BUPS model is installed) of backup power for the repeater before
shutdown. (The AC source powers the charger.)
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Battery Low Alarm

Indicates that battery voltage of the
BUPS is below operating tolerances and
the BUPS cannot power the repeater.

Battery High Alarm
Indicates that battery voltage of the
BUPS is above operating tolerances and
the BUPS cannot power the repeater.

Charge Fail Alarm
Indicates that the internal charger of the
BUPS has failed and the BUPS is
unable to recharge its batteries.

Summary Alarm

Ao |

Description
AL Fall Alam Status
Low Baitery Alarm Status
High Battery Alarm Status
Chaige Fal Alarm Status
UPS Sumnary Alam Status
Tampes Alam Slatus

Indicates that one or more of the BUPS alarms have been triggered.

Tamper Alarm
Indicates that the door of the BUPS is open.
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Chapter 5. RepeaterNet Commands

Commands available from the OA850C NR Main Control screen’s menu bar are described in this chapter.

File Menu—OQA850C Craft

Open the Main Control screen File menu to display the RepeaterNet commands described in this section.

Download Properties

You can download all settings previously uploaded to a repeater with the Download Properties command.
You can use Download Properties to:

QO Download the default configuration file distributed with your Craft software to avoid having to manually
configure each setting.

o If you have used the Upload Properties command to store repeater configuration settings.

The following preset configuration files are distributed with RepeaterNet Craft installation software and can
be found by following this path:

Program Files -> Repeater Technologies -> RepeaterNet Craft 2.1 -> Config Files

Configuration File Configuration
QAB50C_2_Chan_NMS.rcf OAB50C repeater without modem or phone
OAB50C_2_Chan_ModemPhoneNMS.rcf OA850C repeater with modem or phone

To download settings to a repeater using the standard repeater configuration file:

1. From the Craft Main Control File menu, select Download Properties; a confirmation box is displayed
to give you an opportunity to change your
mind about the download operation.

Select file to restore repeater properties from

2. Click on OK to proceed; a Select file to ] _
restore box is displayed. Lockjrs | 23 Confgusion Fies 2
‘ ') A1800C_1_Chan_ModemPhonePager.ccf 1@ OABD0_2_Chan_Mod
3. Select the repeater configuration file 4] DA1900C_1_Chan_NMS. rct L:]]UABBII_Z_Chan_NME
whose properties you want to download. 'a] DA1300C_2_Chan_ModemPhonePager. rcf
[#] DA1900C_2_Chan_NMS.rct
4. Click on Open to proceed with the %OABO[I_J_Chan_ModemPhonePagel.lcl
download. w| DABOD_1_Chan_NMS.rcf
i1 I R e R
Upload Properties N -
Fie pame: @ ] I Qpen ]
System settings are stored in a repeater Flesof lype:  |Repeates Configuration Files {*1ef) v
configuration {.rcf) file, which you can use to e = e L—&Lcel—-]
downioad all settings from one repeater to [ Open as jead-only

additional repeaters in a network, or to
configure a replacement unit.

Once you have configured a repeater, you can upload the configuration from that repeater to your
workstation with the Upload Properties command. You then can use the Download Properties
command to copy the configuration to individual repeaters in your network.

To upload system settings and create a repeater configuration file:
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1. Select a repeater and open Craft.

2. Select File->Upload Properties to open the
Select a file to save repeater properties to
dialog box.

3. Enter a name for the file without a file extension.
An .rcf extension is added automatically to the
file name; for example, filename.rcf.

4. Click Save to initiate the upload.
5. Ciick OK when the upioad is complete.

Save a copy of the repeater configuration file on a
floppy disk for safekeeping.

‘&) now13c.rct W} DASDO_1_Chan_Mod
] 0a1900¢.sct im] DABOD_1_Chan_NMS
=] 0A1500C_1_Chan_ModemPhonePager. rcf 1] BABOD_2_Chan_Mod
ﬁnm S00C_1_Chan_NNS.rct (] 0ASD0_2_Chan_NM¢

] 0A1900C_2_Chan_ModemPhonePager. rcf
w] DA1 300C_2 Chan_NMS.ict

1}

Fie prame:
Save as ype:

[~ ] | [ sove
e —
7] Open a2 jead-only

NOTES:

Q  When you create a backup file, be aware that Repeater Configuration {.rcf) files created using a

Network Monitor login include IDs and passwords.

O The Repeater Configuration (.rcf) file is saved in the RepeaterNet program directory.

Update Repeater Firmware

Install a firmware upgrade with the Update Repeater
Firmware command. Note that firmware updates are
sent automatically to the designated point of contact
for every affected owner of the repeater. Update
packages are sent using overnight delivery and include
a detailed notice, a floppy disk, and installation
instructions. Any questions concerning the update
should be directed to the Repeater Technologies
Customer Service Department.

To install a firmware upgrade:

1. Read documentation provided with the firmware
upgrade. ‘

2. Login to a session with the repeater to be
upgraded.

3. Insert the upgrade disk into the computer's floppy
drive.

4. From the Main Control screen menu bar, select
File->Update Repeater Firmware.

An Open dialog box is displayed to let you save
the repeater’s configuration. You can choose to
select a file into which the configuration should
be saved, or click on Cancel to proceed with the
firmware update.

Select o bie

Save

to save repeater prupertics to

[ 23 Conligearation Fies =1 8] =] =2

] 0a1900c, ref
8] 0A1906C_1_Chan_ModemPhonePager.rcl = 0A800_2 Chan_Mod
8] DA1900C_1_Chan_NMS.icf

4] 0A1900C_2_Chan_ModemPhonePager,ref
] GA1900C_2_Chan_NMS.rcf

1] DAB00_1_Chan_ModemPhonePager.ic!

] DABOD_1_Chan_NMS

2] 0ABOG_2_Chan_NMS

T

R T T

File paiver
Save as ype:

= ]
[Prepeater Configuration Fies ref) ] {7 Cacel |

[ Open as jeadonky

Select a firmware lile to download to the iepeater

tokpe  [Fm_ Faer 1 &) o] )

Fiepame: | P Qe ]

Fles of type:  [Fumware fles [.09] =]
I] Open as read-oniy

— To save the configuration and continue with the firmware update, select an .rcf file

and click Open.

—  If you do not want to save the repeater configuration, click on Cancel.
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" —  Clicking Open or Cancel causes the upload operation to praceed; an Uploading Repeater
window displays the progress of the upload.

5. When the upload is complete, the Selecta firmware file to download to the repeater box is
displayed. In the Look In box, select the drive in which the upload disk is located.

6. Double-click the upgrade file. It is labeled with an _s09 extension—for example, filename.s09. The
previous firmware version is overwritten.

7. When the upgrade is complete, the repeater’s configuration is restored automatically from the file you
chose in the Open dialog. ‘

Exit

The Exit command ends an active session with RepeaterNet and returns to the Welcome screen.

Configuration Menu—OQOA850C NR Craft

Initial configuration of the repeater is done from the Configuration menu commands. See Chapter 4.
Configuring OAB50C NR Properties on page 10 for detailed information.

System Menu—OA850C NR Craft

Open the System menu to display the Properties and Alarm and Event Log commands described in this
section.

Properties

Select Properties from the System menu to open the System Properties screen.

NOTE: When the repeater is on a network, the system name must be entered to match that at the Network
Managerment Station in order for unsolicited alarms to be recognized.

System Tab |
The S b includes data fields f Spien sl | S |

e System tab includes data fields for storing site- .
specific information—the system name {name of the System Nome: e
repeater), brief site information (such as a network name Si Infol: [Come
or city location), and the repeater phone number for & _ 0
repeater with a modem option. Site Info2 [

Site Phore Humber, |§§§ =l

Entering summary data on the System Tab, although
optional, is recommended. As a minimum, type a name
for the repeater in the System Name field: during
automatic reporting, the repeater name is displayed in the
title bar of the Main Control screen, identifying the
selected repeater. ok ] Coes | &b | oo |

To record system data:

1. Type required information in the data fietds.
2. Click Apply or OK.
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System Inventory Tab

The System Inventory tab includes data fields that provide information about the repeater to which you
are connected. RepeaterNet reads this information directly from the repeater upon successful login.

These information-only fields are described as follows:

Assembly Part Number
The part number of the repeater (for example,
090-1200-09).

Serial Number ‘
The 8-digit serial number of the repeater.

Date Code:
The date the repeater was built.

Hardware Revision
The repeater hardware revision (such as Rev. A).

Boot Code Version
The version of the boot code installed in the
repeater.

Installed Options .

Optional internal equipment in the repeater (such as a cell phone).

Firmware Version
The firmware version installed in the repeater.

Login Tab

The Login tab includes fields to type in login IDs and
passwords and to configure the Auto-Logout function.

In the Auto-Logout Inactivity Time field, define how
long RepeaterNet should wait, during a period of
inactivity, before terminating a session. A time interval
in minutes between 1 and 60 can be defined
independently for each access level. if you entera
zero in a time field, this feature is disabled.

NOTE: When the repeater is part of a network, the
time field must be zero (0).

To change a login ID or password:

Login to the repeater (as an administrator).
Select Properties... from the System menu.
Click the Login tab.

Click Apply or OK to set the new information.

NoghLn~

o~
System [S73om Iventoy ] System Login |
Assembly Part Number: r‘f;“;“_
Sedial Number: =
Date Code: M
Hardware Version: -~
Boot Cade Wersion [
Installed Options: .
Firrmware Vessiorc —
[k ] coce | hoo |
System Properties 1| g
System | System Inverdory  System Login |
Login Type Login D Password .m%".‘;
O
Network Monitor  [NETMON [oas00 P 3
S 3
[0 ] o | o |

Notify affected operators of ID and password changes.

Type the new login ID or password (using six or fewer characters) into the appropriate fields.
Write down login IDs and passwords and secure in a safe place.

NOTE: When the repeater is networked, this information also must reside in the NMS Database.
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Alarm and Event Log

Open the Alarm and Event Log from the System menu to view the alarm and event history of the
OA1900 NR. The log is dynamically updated during viewing.

Line entries in the Alarm and Event Log are organized as follows:

1. Subsystem affected by an alarm or event
2. Alarm severity
3. Date and time stamp

Saving , Printing, and Editing the Log

Alarm and Event Log entries can be printed, saved, or edited using Notepad. Click on Run Notepad; a
copy of the Alarm and Event Log is displayed in a Notepad window, in which you can edit the log. To print
or save the log, select Print or Save as... from the Notepad File menu.

Options Menu—OA850C NR Craft

Open the Options menu to display the Color Independent Icons and Alarm Sounds RepeaterNet
commands.

Color Independent Icons

Color Independent Icons are special graphic indicators designed to assist operators unable to distinguish
colors. As part of the alarm reporting system, Color Independent lcons display on the Main Control screen
for a Critical, Major, or Minor alarm. By default, the Color-Independent Icons feature is OFF.

From the Main Control screen menu bar, select Options->Color Independent Icons to turn ON this
feature.

Alarm Type Color Independent icon

Critical Alarm X

through subsystem icon

Major Alarm AN through subsystem icon

*
‘0

Minor Alarm *, through subsystem icon
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Alarm Sounds

The Alarm Sounds feature allows for an intermittent alarm to activate when a subsystem triggers an alarm.
By default, the Alarm Sounds feature is OFF.

From the Main Control screen menu bar, select Alarm Sounds from the Options menu to turn ON this
feature.

NOTE: During an alarm, either clicking a subsystem icon to open the Status screen or clearing the alarm
silences an audible alarm. -

Hold Connection

The Hold Connection feature maintains the direct or dial-in connection to the repeater for monitoring until
you terminate the connection.

Help Menu—OAS850C NR Craft

RepeaterNet on-line help is designed to provide quick access to information related to the operation of the
repeater.

O To open RepeaterNet Help, select Help->Help Topics.

Q@ Tolearn about the version of RepeaterNet Craft, RepeaterNet NMS, or RepeaterNet Administrator
installed, select About... from the Help menu of any program window.

Navigating Help

O  From the Contents tab, double-click a book icon to open its contents, then double-click a topic icon to
open its Help page. A help page provides detailed topic information. Help pages can contain links—
identified by green, underlined text—to related topics.

Q  From the Index tab, type a topic name in the data field to automatically jump to a topic or use the
scroll bar to locate a topic entry. Double-click an index entry to open its Help page.

Q  Click the Index tab to open the Find Setup Wizard utility, which searches for specific words and
phrases instead of searching by category. Follow the prompts.

O Tofind out the version of RepeaterNet in use, select About from the Main Control screen Help menu.

Exiting RepeaterNet

To exit RepeaterNet, return to the Main Control screen File menu and select Exit.
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Appendix A. Default Alarm Settings

Subsystem Option Alarm Default Setting
Front End Forward Fwd FE Alarm Critical
Reverse RevFE Alarm Critical
RevFEProtect Alarm Critical
Diversity DiversityFE Alarm Critical
Channel 1 Reverse PA Rev PA Alarm Critical
Rev PA VSWR Alarm Disabled
Rev PA Thermal Alarm Major
Rev PA Ext Shutdown Alarm Disabled
Forward PA Fwd PA Alarm Critical
Fwd PA VSWR Alarm Disabled
Fwd PA Thermal Alarm Major
Fwd PA Ext Shutdown Alarm Disabled
PA Control Reverse PA OFF
Forward PA COFF
Reverse Filter CSF Rev Alarm Event
Forward Filter CSF Fwd Alarm Event
Gain Forward and Reverse 65DB
Channel 2 Reverse PA Rev PA Alarm Critical
Rev PA VSWR Alarm Disabled
Rev PA Thermal Alarm Major
Rev PA Ext Shutdown Alarm Disabled
Forward PA Fwd PA Alarm Critical
Fwd PA VSWR Alarm Disabled
fwd PA Thermal Alarm Major
Fwd PA Ext Shutdown Alarm Disabled
PA Control Reverse PA OFF
Forward PA OFF
Reverse Filter CSF Rev Alarm Event
Forward Filter CSF Fwd Alarm Event
Alarm Control Unit (*If external inputs or equip- | External Input 1* Alarm Disabled
{ACU) ment are used, set alarm External Input 2* Alarm Disabled
severity as appropriate.) Temperature Alarm Minor
‘ Tamper Alarm Major
Analog Input Alarm Disabled
Ext. Growth Box Alarm Disabled
Power Supply Channel PS Input Power Critical
Power Supply Alarm Critical
Battery Alarm Minor
Backup Power AC Fail Alarm Disabled
Supply Low Battery Alarm Disabled
High Battery Alarm Disabled
Charge Fail Alarm Disabled
UPS Summary Alarm Disabled
Tamper Alarm Disabled
Modem Modem Alarm Minor
Cell Phone Call Phone Alarm Minor
Craft for the OA1900C NR Appendix A. Default Alarm Settings — Page 33




Prefiminary Draft — RTI Confidential

Appendix B. RepeaterNet Executables

The installation program instalis all necessary application executables and associated support drivers in a
Windows folder you select or, by default, in ¢: \Progran Files\Repeatexr Technologies) RepeaterNet.
The installation program also provides entries into the system registry.

The main RepeaterNet executable files are:

CraftAdmin .
The Database Administrator program used to configure and select the communications port used by
RepeaterNet Craft.

RepeaterNet :
The Craft graphical user interface for different repeater hardware types. Used in the setting and
viewing of individual repeater items.

When any of these executable files are running, an icon is displayed on the Windows Task Bar.
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Appendix C. The Oki Cellular Phone

Accessing the OKI Cellular Phone

The cellular phone is located on the inside door of the OA850C NR entry box. Unscrew the four screws
securing the metal box lid. '

"] Internal i
Battery i

Cellular l
Phone

NOTE: The AC charger and cell phone antenna are provided in the accessory kit,

Programming the OKI Celiular Phone

An abbreviated set of instructions for NAM programming of your Oki Phone is provided
in this section. For more detailed information, see your OKI PHONES 1400 Series
documentation.

Programming Mode Access
1. Turn the power on and press Rel + Func keys at the same time.
2. Enter your 5-digit special password within 30 seconds.

3. After the special password is logged in successfully, ESN/HEZ Number and Software Version
Number are displayed for two seconds each.

4. Two seconds later the Speed Dial Memory reset prompt is displayed.

Craft for the OA850C NR Appendix C. The Oki Celular Phone — Page 35




Preliminary Draft - RTI Confidential

5. Proceed to the next section, “Speed Dial Memory Clear,” or press volume Y4 to scrolt within the NAM
Programming menu.

Speed Dial Memory Clear

Scroll the NAM Programming Menu until “Spd dial” appears n the display, followed by the reset prompt
(“reset-0"). Press 0 to clear the Speed Dialing Memory.

Default Data Set

Scroll the NAM programming menu until “def data” appears on the display, followed by the reset prompt
(“reset-0"). Press 0 to reset ail user programmuable functions to the Manufacturer's default.

Lock/Unlock Code Programming

1. Scroll the NAM Programming Menu until “Uloc and {current code)” appears on the display. The defautt
is “1234."

2. Enter a new 1-to-4 digit unlock code and press Sto key.
Telephone Number Programming

1. In this menu, you can program information that is unique to Telephone #1. Follow the instructions or
press CIr to skip to Telephone #2 or the next item on the main NAM Programming menu.

2. The display indicates “tel.no 1" followed by the tast seven digits of the current phone number. Enter
the new number (area code plus telephone number) and press Sto.

Authentication Key Programming

The display indicates “Auth.no.” followed by “Entr.no.” Enter the authentication key provided by the carrier
{up to 26 digits) and press Sto. If an invalid number is entered, the display shows “not good” followed by
“Entr.no.”

Home SID Programming

Enter a 5-digit SID number and press Sto. The IPCH Number Initial paging channel number is set
automatically depending on the stored Home SID number.

ACCOLC Number
The current number is displayed. Enter a new number if required, then press Sto.
GID Number

1. The current number is displayed. Enter a new number if required, then press Sto.
2. Press CIr to return to the main NAM Programming menu.

Emergency Number

1. The display shows “Help no.” and the current setting. Enter a new number (up to 11 digits) if required.
2. Press Sto.

Preferred SID Programming

1. Scroll the Preferred NAM Programming menu. Press Rel and enter the desired Preferred SID number
(5 digits).

2. Press Sto. You can enter up to 50 SID locations.
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3. Press Clr key to advance to the next programming option.

Language Option Set

Press Rel and scroll through the available options. When the desired language is displayed, press Sto.

System Options Programming

1. Scroll the NAM Programming menu and press Rel to enter the Option Programming menu.

2. While in this menu, press Rel to change settings and Sto to save and go on to the next setting. Press
Cir at any time to return to the main NAM Programming menu.

Option bits are defined as follows: 0 0 0 1 1

010

0 = "Reserved for future use
0 = Reserved for future use
0 Reserved for future use
1 MINMK = Mobile ID Number Mark {0=No, 1=Yes)
1 = LUMK = Local Use Mark (0=No, 1=Yes}
0 = AMMK = Audio Mute Mark (0=Call, 1=Always)
1 = HFMK = Handsfree Mark (0=No, 1=Yes)
0 = HAMK =Horn Alert Mark (0=No, 1=Yes)
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Appendix D. Troubleshooting —

The following attempts to identify the most common problems associated with the successful operation of
the RepeaterNet system. The steps listed to resolve the problem may not include all of the possible
reasons for non-operability, but may assist in identifying the actual difficulty. The problem attributes in the
following paragraphs have been ordered with the most likely problem listed first.

It you continue to have problems, call Repeater Technologies Customer Support for assistance. See
inside the front cover of this document for current telephone numbers.

Problem 1: The RepeaterNet Server reports that it cannot open the NMS database.

Either the DSN is configured improperly, does not point to the proper location, or the system did not find
the DSN itself. Call Customer Support for assistance.

0 The correct DSN or User ID is not identified.
O  The Windows ODBC drivers are not installed.
O The database file pointed to by the DSN is corrupted or needs repair.

Problem 2: The Process Manager component of the RepeaterNet Server reports that it cannot
read the database Poris table.

No ports have been configured in the system database.

The Ports table in the database may be corrupted. Repair the database and retry.

Problem 3: The System starts up without error but, when a repeater graphical user interface is
launched, no detailed data is displa yed..

Wait for up to 4 minutes (cell modem connection) to see whether the program can connect to the repeater,
If not, a warning will pop-up indicating communications could not be established.

Problem 4: A specific port does not seem to be in use and an Alert exists, or the database log
reports the error “Unable to initialized port COMn” where n is the designation of the
non-functioning port.

The port number has been configured incorrectly or the port does not exist.

The port is assigned to another program operating in the same PC. Windows does not permit the sharing
of communications ports between active programs. Shut down the other program.

Problem 5: The system reports “Unable to connect to repeater...”

This can be an indication of-:

The cellular carrier is not handling the cali

The phone number provided is incorrect or out of service
A problem with the modem or phone line

A problem with the repeater

Ooop
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Problem 6: The system reports the message “An unsupported operation was attempted.”

This message appears when the installation failed to register the OLE controls for alarm bitmaps.

Problem 7: RepeaterNet conflicts with Microsoft Fax.

To disable the auto answer mode:
1. Open the mail icon from the Control Panel.

Select Microsoft Fax from the Services tab.

2

3. Click on the Properties button.

4. Select either Manual or Don’t answer radio button.
5

Click OK to save.

Problem 8: NMS Client reports “Cannot find application RepeaterNet Server.”

This can occur when the Server is not running or a network failure prevents the NMS Client from
connecting to the Server. Verify that the Server is running and that the Server's host is accessible.

Another possibility is a conflict with the port éssigned to the Server. This problem has been known to occur
with a port number that previously had no conflict. Run the program “RepNetConfig.exe” in the
RepeaterNet directory and increase the value of “Server Port” by one. Restart the Server and NMS Client.
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End of Document
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